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1 - Planning Your
Installation

In this section

Installation Scenarios 5
System Requirements 8



Installation Scenarios

Spectrum™ Technology Platform supports a variety of installation scenarios that scale to fit the
needs of your organization.

Standard

The standard scenario is the simplest installation scenario. You install Spectrum™ Technology
Platform on a single server. All activity is handled by this one server, including designing dataflows,
storage of configuration information, running jobs, and handling service requests.

Remote Servers

Remote servers are useful if you have licensed many modules. To use remote servers, you install
Spectrum™ Technology Platform on several different servers, installing different modules on each
server. You then configure the individual services to execute on one of the remote servers. This
approach has the following advantages:

• Improved performance, especially for web service and API calls. For jobs, there may be some
performance improvement, but the time it takes to send data across the network to the remote
server may offset any performance gains.

• Ability to perform database updates on individual modules without interrupting the availability of
other modules. For example, if you need to update a postal database for the Universal Addressing
Module, you could install the update by stopping just the remote server handling the Universal
Addressing Module, allowing other modules to remain available on other remote servers.
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• Startup time can be reduced. With all modules on one server, it can take a long time for the server
to start up. With modules installed on separate servers, each server will start up more quickly.

Cluster

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Instead of
using the URL and port of the Spectrum™ Technology Platform server, you use the URL and port
of the load balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

The following diagram illustrates this architecture:
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This approach has the following advantages:

• Processing is automatically distributed among the nodes in the cluster for optimal performance.
• Configuration settings are automatically synchronized across nodes.
• Uptime can be improved since if a node goes down the other nodes remain available to handle
processing requests.

• Adding a new node is easy.

Cluster with Separate Configuration Database

When you install the Spectrum™ Technology Platform server you are installing two things: server
software and a configuration database. The server handles the execution of jobs and service
requests, reporting, and logging. The configuration database stores data such as users and roles,
data connections, dataflows, and the audit log.

For clusters consisting of only a few nodes, installing the server and configuration database together
on the same server provides acceptable performance. However, a cluster that consists of a large
number of nodes may have its performance negatively affected by having a copy of the configuration
database on each node. This is because an increasing number of nodes results in increased data
replication between nodes during synchronization. Performancemay also suffer if users are accessing
the configuration database frequently through activities such as editing dataflows or job schedules.
These activities require processing power, resulting in less CPU capacity available for running jobs
and responding to service requests.

If you have an implementation with four or more nodes, you should consider installing the
configuration database to separate servers. This is the most scalable installation scenario because
you can add nodes without necessarily adding another instance of the configuration database. For
example, say you have five nodes and three configuration database servers. You could add another
five nodes, bringing the total number of nodes to 10, while still using just the three configuration
databases to support all 10 nodes.

Installing the configuration database to a separate server has the following advantages:
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• More CPU is available to the server for running jobs, process flows, and service requests because
reading and writing to the configuration database is handled by a separate server.

• Reduced network traffic due to reduced configuration data replicated between nodes. For example,
you could have five Spectrum™ Technology Platform servers for handling execution while having
only three repositories. With just three repositories instead of five, data only needs to replicate
between three servers rather than five.

• Most scalable installation scenario.

System Requirements

Server Requirements

Operating Systems

Spectrum™ Technology Platform is supported on the following operating systems.
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NotesOperating System

None.Windows Server 2008 R2

The Enterprise Tax Module is not supported on R2.Windows Server 2012 R1 & R2

64-bit Required

The Spectrum™ Technology Platform server requires a 64-bit Unix, Linux, or Windows operating
system. 32-bit operating systems are not supported.

Disk Space

Spectrum™ Technology Platform has the following disk space requirements.

UpgradeNew Installation

• Free disk space equal to three times the size of your
current installation. To determine the size of your current

• 3 GB to install all modules, less if installing fewer modules.
• 4 GB to 5 GB of temp space for the installation to extract
the files it needs, but you may need more depending on installation, look at the size of the folder where you

installed Spectrum™ Technology Platform.the options you are installing. If necessary, modify your
TEMP environment variable (Windows) or IATEMPDIR • If you are adding modules as part of your upgrade, you

will need 3 GB to install all modules, less if installing fewer
modules.

environment variable (Unix and Linux) to point to a
location with enough space.

• 4 GB to 5 GB of temp space for the installation to extract
the files it needs, but you may need more depending on
the options you are installing. If necessary, modify your
TEMP environment variable (Windows) or IATEMPDIR
environment variable (Unix and Linux) to point to a
location with enough space.

If you are installing a module that uses a reference database, such as a postal database,
geocoding database, or data normalization tables, you will need space for this data. The

Note:

total disk space varies, depending on what modules(s) and what database(s) you are
installing.

Memory

• Basic memory requirement: 8 GB
• The Enterprise Geocoding Module requires an additional 500 MB memory for the first non-U.S.
geocoder, and 250 MB for each additional non-U.S. geocoder, with these exceptions:

• Germany, Australia, and the U.K. each require 1 GB additional memory
• Japan requires 2 GB additional memory
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Note that you may distribute processing among multiple servers which may allow you to take
advantage of existing hardware instead of adding memory to a single Spectrum™ Technology
Platform server. This is referred to as remote server processing. For information on remote servers,
see the Spectrum™ Technology Platform Dataflow Designer Guide.

• The Location Intelligence Module requires an additional 2 GB RAM to support its mapping and
feature components.

• The Data Normalization Module and Universal Name Module require additional memory if you
use the following name databases:

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

Additional Requirements

• Windows administrator rights

Client Tools Requirements

Enterprise Designer, Management Console, and Interactive Driver require the following:

• Operating system requirements:

• Windows XP
• Windows 7

• 86 MB of disk space to install the client without any modules. Each module you install requires
additional disk space.

• Microsoft .NET Framework 4.0 (available from the Spectrum™ Technology Platform Welcome
Page, http://<SpectrumServerName>:8080)

• The Administration Utility requires Java 8 or later. If you are installing the Administration Utility on
the same computer where the Spectrum™ Technology Platform server is installed, Java 8 is
already installed since it is included with the server. If you want to install the Administration Utility
on another computer, make sure that the computer has Java 8 or later installed.

• A monitor with at least 1024 x 768 resolution
• Maximum Windows DPI setting: 150%
• Adobe Reader 7 or later (for viewing and saving reports)
• To use the deprecated Business Steward Portal or the Data Hub Relationship Analysis Client, a
browser with Microsoft Silverlight 5 installed. See www.microsoft.com/getsilverlight. Note that
Google Chrome is dropping support of Microsoft Silverlight in September 2015. At that time you
will need to access these client tools using Internet Explorer (version 11, ideally) or Firefox.

• To use the new Business Steward Portal or the Data Hub Browser, a Web browser is required.
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Web Browser Requirements

• Internet Explorer 10 or later
• Google Chrome 43 or later
• Firefox 38 or later

User Interface Languages

Spectrum™ Technology Platform user interfaces such asManagement Console, Enterprise Designer,
Interactive Driver, and web-based applications are localized for the following languages:

• English
• French
• Japanese
• Portuguese
• Spanish

Client SDK Requirements

The Client SDK provides API access to Spectrum™ Technology Platform services. To use the Client
SDK your computer must meet the following requirements:

• 1.25 GB disk space
• JDK 1.5 is required to install the Client SDK. Be sure that JDK 1.5 is in the PATH environment
variable. Once installed, the Client SDK supports JDK 1.4 and greater.

Supported Compilers

The Spectrum™ Technology Platform Client SDK is supported with the following compiler and
runtime minimum versions.

Java

Client SDK Package Directory: clientSDK/platforms/java

Client SDK requires the Java JDK, version 1.4 or higher. This is not installed with the Client SDK.

Windows 32-bit

• JDK: 1.4
• C Compiler: MSVC 6.0 SP3, MSVC 2003, MSVC 2005, MSVC 2008
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• C++ Compiler: MSVC 6.0 SP3, MSVC 2003, MSVC 2005, MSVC 2008
• C# .NET: Microsoft .NET Framework 1.1
• Visual Basic: MS Visual Basic 6.0

Windows 64-bit

• JDK: 1.4
• C Compiler: MSVC 2005, MSVC 2008
• C++ Compiler: MSVC 2005, MSVC 2008

HP-UX RISC

• JDK: 1.4
• C Compiler: cc: HP92453-01 A.11.01.21 HP C (Bundled) Compiler
• C++ Compiler: aCC: HP aC++ B3910B A.03.30 HP aC++ B3910B A.03.27

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.1
• librt.2
• libnsl.1
• libxti.2

The clientSDK 64-bit lib is linked to the following libraries:

• libpthread.1
• libnsl.1
• librt.2
• libdl.1
• libc.2
• libxti.2
• libdl.1

HP-UX Itanium

• JDK: 1.4
• C Compiler: cc: HP aC++/ANSI C B3910B A.06.05
• C++ Compiler: aCC: HP aC++/ANSI C B3910B A.06.05

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.so.1
• libnsl.so.1
• librt.so.1
• libxti.so.1
• libdl.so.1

The clientSDK 64-bit lib is linked to the following libraries:
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• libpthread.so.1
• libnsl.so.1
• librt.so.1
• libxti.so.1
• libdl.so.1

Red Hat (32-bit)

• Operating System: Red Hat Linux 2.4.9-e.65smp
• C Compiler: gcc version 2.96 (gcc 4.1 required for the Address Now Module)
• C++ Compiler: g++ version 2.96

The clientSDK lib is linked to the following libraries:

• libstdc++-libc6.2-2.so.3
• libm.so.6
• libc.so.6
• ld-linux.so.2

Red Hat (64-bit)

• Operating System: Red Hat Linux version 2.6.9-34.0.2.ELsmp
• C Compiler: gcc version 3.4.5
• C++ Compiler: g++ version 3.4.5

The clientSDK lib is linked to the following libraries:

• libstdc++.so.6
• libm.so.6
• libgcc_s.so.1
• libpthread.so.0
• libc.so.6
• ld-linux-x86-64.so.2

SuSE

• Operating System: SuSE SLES 8 (powered by UnitedLinux 1.0) (i586)\nKernel 2.4.21-295-smp
(0).

• C Compiler: gcc version 3.2.2
• C++ Compiler: g++ version 3.2.2

The clientSDK lib (32-bit) is linked to the following libraries:

• libstdc++.so.5
• libm.so.6
• libgcc_s.so.1
• libc.so.6
• ld-linux.so.2
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Solaris

• Operating System: Solaris 5.8
• C Compiler: cc: Forte Developer 7 C 5.4 2002/03/09
• C++ Compiler: CC: Forte Developer 7 C++ 5.4 Patch 111715-16 2005/04/28

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.so.1
• libsocket.so.1
• libnsl.so.1
• librt.so.1
• libc.so.1
• libdl.so.1
• libmp.so.2
• libaio.so.1
• libc_psr.so.1

The clientSDK 64-bit lib is linked to the following libraries:

• libpthread.so.1
• libsocket.so.1
• libnsl.so.1
• librt.so.1
• libc.so.1
• libmp.so.2
• libmd5.so.1
• libscf.so.1
• libaio.so.1
• libdoor.so.1
• libuutil.so.1
• libm.so.2
• libc_psr.so.1
• libmd5_psr.so.1

AIX

• Operating System: AIX version 5.1.0.0
• C Compiler: xlc 6.0 Visual Age C 6.0
• C++ Compiler: xlC 6.0 Visual Age C++ 6.0

The clientSDK 32-bit and 64-bit lib are linked to the following libraries:

• libC.a
• libc_r.a
• libpthread.a
• librtl.a
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Default Network Ports

The Spectrum™ Technology Platform server uses several network ports for communication. Network
port conflicts can result in module components failing to start up. One indication that a component
has failed to start up is if it does not appear in the Management Console. To troubleshoot the problem,
look in the Spectrum™ Technology Platform log file. This log shows which port is causing the problem.
You can find the Spectrum™ Technology Platform log file in:

server\app\repository\logs\server.log

The following table lists the default network ports. You can change the ports by modifying the
properties in this file:

server\app\conf\spectrum-container.properties

If you want to change the networks ports used by a cluster, you must modify the
spectrum-container.properties file on each node in the cluster.

Note:

DescriptionPropertyPort

This port is used by the Spectrum™ Technology
Platform configuration database.

spectrum.orientdb.binary.port2424-2430

This port is used by the Spectrum™ Technology
Platform configuration database.

spectrum.orientdb.hazelcast.port2434

This port is used by the Spectrum™ Technology
Platform configuration database.

spectrum.orientdb.http.port2480-2486

This port is used by Hazelcast for managing
distributed processing between Spectrum™

Technology Platform servers in a cluster.

spectrum.hazelcast.port5701

The port used for communication between the
server and Enterprise Designer, Management

spectrum.http.port8080

Console, and Interactive Driver. This port is also
used by web services.

This port is used for API calls made to services.spectrum.socketgateway.port10119

15Spectrum™ Technology Platform 10.0 SP1 Installation Guide

Planning Your Installation



Location Intelligence Module Support

Database

The Location Intelligence Module supports the following spatial databases for use with the spatial
services, data, and resources:

• Oracle 11gR2
• SQL Server 2008 R2, SQL Server 2012
• SAP HANA 9.3
• PostgreSQL 8+ (PostGIS 1.5 and 2.x)
• GeoPackage (Windows and CentOS)

Data Format

The Location IntelligenceModule supports the following data formats for use with the spatial services:

• Generic JDBC (w/XY)
• TAB (native, raster, grid, seamless, DBF)
• ESRI ShapeFile

Raster Format

The following raster and grid formats (64-bit only) are supported in the Location Intelligence Module:

Raster formats:

File ExtensionFormat
.genADRG

.genASRP

.bmp, .wbmpBMP

.genCADRG

variousCIB

.ecwECW (SDK v5)

.geotifGeoTiff

.gifGIF

.jpg/.jpegJPEG

.mrrMRR (Multi-Resolution Raster)

This support is provided on Windows 64-bit and the
following Linux environments:

Note:

• Oracle Linux 6.5 and 7.1
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• CentOS 6.4 and 7.1
• Ubuntu 12.04

.sidMrSID (SDK v9)

Supports MG4 (MrSID Generation 4). On CentOS 7.1,
libpng12.so is required for reading MrSID rasters.

Note:

.ntfNITF

.pngPNG

.tifTIFF

Solaris or AIX machines, whether installed with 32- or 64- bit JVM, do not support ECW and
MrSID raster formats.

Note:

Grid Formats

File ExtensionFormat
.dt0, .dt1, .dt2, .dt3Defense Digital Terrain Elevation Data (DTED)

.migMapInfo Grid

.grcVertical Mapper Classified Grid

.grdVertical Mapper Continuous Grid

In order to use rasters and grids as a map layer, there must be an associated .TAB file containing
georeference information about the image, including the bounds, coordinate system and registration
points.

Browser
The Location IntelligenceModule spatial client development, samples, and SpectrumSpatial Manager
support the following browsers:

• Microsoft Internet Explorer 10 and 11
• Mozilla Firefox 35 and above
• Google Chrome 40 and above
• Safari (Mac OS X) and Safari 5.1.7 for Windows

Utilities

The Location Intelligence Module utilities (Tile Generator, Map Uploader, Geometry Validator) have
the follow requirements:

• These utilities require at a minimum Java 7. If you are installing these utilities on the same computer
where the Spectrum™ Technology Platform server is installed, Java 8 will be installed since it is
included with the server. If you want to install the utilities on another computer, make sure that
the computer has Java 7 or later installed.
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• The Map Uploader also requires Microsoft .NET Framework 4.0 (available from the Spectrum™

Technology Platform Welcome Page, http://<SpectrumServerName>:8080)

OGC Compliance

The Location Intelligence Module is OGC compliant for the following services:

• WFS version number 1.0.0
• WMS version number 1.1.1 and 1.3.0

MapInfo Professional Compatibility

The Location Intelligence Module is compatible with MapInfo Professional up to version 15.x. See
Tools > MapInfo Pro in the Spectrum Spatial Getting Started Guide for more information about the
interoperability of the two products.
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Installing a New Server

Before installing Spectrum™ Technology Platform, be sure to read the release notes. The release
notes contains important compatibility information as well as release-specific installation notes.

You may encounter installation problems onWindows if the data execution prevention (DEP)
setting is not set correctly. The DEP setting must be set to Turn on DEP for essential

Note:

Windows programs and services only. For instructions on how to change your DEP setting,
see the Windows documentation.

1. Download Spectrum™ Technology Platform using the download instructions contained in your
welcome letter.

2. Extract the downloaded file to a temporary location on the server where you want to install
Spectrum™ Technology Platform.

3. If you are installing on Windows Server 2012 R2, do the following:
a) Right-click on install.exe and select Properties.
b) Click the Compatibility tab.
c) Check the box Run this program in compatibility mode for and selectWindows 7.
d) Click OK.

4. Double-click install.exe.
5. The installer walks you through the installation process. Note the following:

• If you are setting up an environment where the configuration database is installed on a separate
server choose Server only. Otherwise choose Standard installation.

• When prompted, select the modules that you want to install.

• Make sure that Spectrum™ Technology Platform is selected.
• If you are installing the SAP Module you must install these modules: Address Now Module
and Advanced Matching Module. The Enterprise Tax Module is optional. The Universal
Addressing Module is only required if you will be using the SAP module service
SAPValidateAddressWithCandidates.

• If you are installing the Siebel Module you must install these modules: Advanced Matching
Module,Data NormalizationModule, andUniversal NameModule Youmay need to install
one or more of these modules depending on the features you have licensed: Address Now
Module, Enterprise Geocoding Module, and Universal Addressing Module.

• When prompted, enter the HTTP port that you want to use and then press Enter. The default
is 8080. For a complete listing of ports used by Spectrum™ Technology Platform see Default
Network Ports on page 15.

6. After the installation completes, the Spectrum™ Technology Platform server starts automatically.
Wait for the server to start up.
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You can see when the server has stared up by opening the log file <Spectrum Installation
Location>\server\app\repository\logs\wrapper.log and looking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform (Version
version build) Started

Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation
to become unusable.

Important:

7. Install your license key. For instructions, see Installing a License Key on page 22.

Upgrading a Server

Before upgrading, be sure to read the release notes for the new version. The release
notes contain important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

Important:

1. Download the updated version of Spectrum™ Technology Platform using the download instructions
contained in the release announcement email.

2. Unzip the downloaded installer to a temporary folder on the server you want to upgrade.
3. Follow the information provided in the release notes for recommendations about backing up

module-specific data. For example, for the Location Intelligence Module, you need to back up
your named resources, data, and configuration files. For the Data Hub Module, you need to follow
the instructions in "Backing up Data Hub Models" from the Master Data Management Guide.

4. Stop the Spectrum™ Technology Platform server. To stop the server, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Stop Server. Alternatively, you
can use the Windows Services control panel and stop the Pitney Bowes Spectrum™ Technology
Platform service.

5. If you have the Address Now Module installed, shut down the Address Now server by going to
the Windows services control panel and stopping the Address Now Server service.

6. If you have the Global Sentry Module installed, shut down the Global Sentry database server by
going to the Windows services control panel and stopping the Global Sentry Database Server
service.

7. Any changes you made to files in the folder <SpectrumPlatformLocation>\server will be
lost. Before upgrading, review the files and folders in this location and back up any files you have
modified.

You may have modified files in this folder in the following situations:

• You have the Siebel or SAPmodules installed. Be sure to back up existing dataflows, especially
any that are customized.
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• You are using LDAP for authentication. Be sure to back up this file and restore it after upgrading:
server\app\conf\spring\security\spectrum-config-ldap.properties.

8. Run the Spectrum™ Technology Platform installer to upgrade your system.
9. If you backed up any files under the <SpectrumPlatformLocation>\server folder, restore

them to the upgraded server.

Any job or subflow stored in the system during a server upgrade is marked as exposed to
provide the same behavior for those jobs and subflows as before the upgrade. Any job or

Note:

subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
these jobs or subflows back into the system, you must manually expose the imported job or
subflow.

Installing a License Key

The license key provides access to software pursuant to the terms of your license. It is an encrypted
XML file with a file name ending in .key.

When you upgrade an existing Spectrum™ Technology Platform installation, youmay continue
to use your existing license key. You do not need to get a new one.

Note:

To install a license key:

1. Locate the email containing your license key that you received from Pitney Bowes.

You must install the license key within 45 days of receiving it. If you do not you will
need to contact Pitney Bowes for another license key.

Important:

2. Copy the .key file to the following directory:

<SpectrumPlatformLocation>\server\app\import

The license key is applied to your system. There is no need to restart your server.

If there was a problem installing the license key, check the log file in:

<SpectrumPlatformLocation>\server\app\repository\logs

Depending on whether the key was processed successfully or there was an error processing the
key, the processed key goes into one of these folders:

• <SpectrumPlatformLocation>\server\app\import\archive\license-keys
• <SpectrumPlatformLocation>\server\app\import\error\license-keys
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Installing the Server with a Silent Installer

The silent install process for the server allows you to pre-configure the server installation process
so that it runs without user intervention. Instead of responding to prompts for information such as
the installation location and which modules to install, you specify these responses in a properties
file which the installer uses instead of user prompts.

1. In the Spectrum™ Technology Platform installer, browse to the SilentInstaller folder.
2. Open the file installer.properties in a text editor.
3. Edit installer.properties as necessary to specify the installation settings you want to use.

See the comments in installer.properties for additional information.
4. To run the installer in silent mode, place installer.properties in the same directory as

install.exe. When the installer executes it will detect installer.properties and automatically
run in silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

install.exe -f PathOfPropertyFile\installer.properties

Adding Modules

Spectrum™ Technology Platform is designed so that modules can be added as you grow your
system over time. For example, you may have one Spectrum™ Technology Platform module and
then license another module a fewmonths later. The second product may be built on a newer version
of Spectrum™ Technology Platform. This will require you to upgrade your version of Spectrum™

Technology Platform. In another case, the second product is compatible with the installed version.
In both cases, the install program recognizes if it needs to upgrade Spectrum™ Technology Platform
and will do so without prompting. If an upgrade is not required, the installer will skip the Spectrum™

Technology Platform install steps and install the new module.

The process for adding a module is similar to that of a new installation. In both cases you start the
installation process by running the Spectrum™ Technology Platform installer. Note that Spectrum™

Technology Platform modules do not have their own installer. Instead, you use the Spectrum™

Technology Platform installer to add modules.

1. If the Spectrum™ Technology Platform server is running, stop the server. To stop the server,
right-click the Spectrum™ Technology Platform icon in the Windows task bar (shown below) and
select Stop Server.
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2. Launch the Spectrum™ Technology Platform installer by double-clicking Install.exe. The
installer walks you through the installation process. When prompted, select the modules that you
want to install. Your currently installed modules are selected.

3. Install any necessary databases for the new product. For more information on installing databases,
see Spectrum Databases on page 64.

4. After you install the necessary databases (if any), start Spectrum™ Technology Platform by
right-clicking the Spectrum™ Technology Platform icon in the Windows task bar and selecting
Start Server.

5. Install the license key for the module. For instructions, see Installing a License Key on page
22.

Removing the Server

Before uninstalling any product, back up any files youmay need in the future. Uninstalling Spectrum™

Technology Platform will remove any job definitions and server-default changes you may have
made.

1. If the Spectrum™ Technology Platform server is running, stop the server. To stop the server,
right-click the Spectrum™ Technology Platform icon in the Windows task bar (shown below) and
select Stop Server.

2. If you are removing Spectrum™ Technology Platform from a Windows Server 2012 R2 machine,
do the following:
a) Right-click on the file and select Properties:

SpectrumLocation\Uninstall\Uninstall_LES\Uninstall_LES.exe

b) Click the Compatibility tab.
c) Check the box Run this program in compatibility mode for and selectWindows 7.
d) Click OK.

3. Go to Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Server and
select Uninstall Pitney Bowes Spectrum™ Technology Platform.

Some Java files will not be removed because the uninstall process itself uses them.Note:

4. If there are any client tools that you want to uninstall, see Removing the Client Tools on page
88.
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Clustered Architecture

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Instead of
using the URL and port of the Spectrum™ Technology Platform server, you use the URL and port
of the load balancer. Consider using this approach if you require failover redundancy and high-volume,
high-performance processing.

The following diagram illustrates this architecture:

Load Balancer

As requests come into the cluster, the load balancer identifies the best available Spectrum™

Technology Platform node to handle the request. The request is then passed to a Spectrum™

Technology Platform node.

From the user's perspective, the distributed architecture is handled automatically behind the scenes.
The user sends a request to the load balancer's URL and port for Spectrum™ Technology Platform
(typically port 80 for a distributed environment) as if it were a single Spectrum™ Technology Platform
server.

Nodes

A node is a Spectrum™ Technology Platform server installation. Each node has a copy of the
configuration database. Each copy is continuously synchronized. This enables each node to share
the same settings. License information, dataflows, database resources, and so on can be centrally
managed for the cluster because of the shared configuration database.

To configure the cluster, simply point Management Console or Enterprise Designer to the load
balancer's URL and port for Spectrum™ Technology Platform (typically port 80 for a distributed
environment).
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External Resources

The definitions for external resources such as database resources (postal databases, geocoding
databases, and so on), JDBC connections, and file servers, reside in the configuration database.
The resources themselves (databases, files, web services) can reside anywhere you choose.

Because the database resources themselves reside outside the cluster, multiple clusters can share
the same database resources. You must create the resource definitions in each cluster using
Management Console. For example if you want multiple clusters to share the same geocoding
database, you can install the geocoding database on a server accessible from each cluster, then
in Management Console point each cluster to the geocoding database.

Clustered Architecture for the Data Hub Module

In a clustered environment, processing is shared among two or more instances of the server. The
Data Hub Module maintains a separate graph database for each model that is configured; each
graph database is replicated to each Spectrum™ Technology Platform server. When a model is
loaded, one server is chosen as the master and all other servers will maintain a replicated mirror of
that master. All writes to the database will be synchronized with the master, while any server can
process read requests.

The server that receives the first request to open the model will be chosen as the master. If different
servers receive the request to open different models, the masters for these models will be running
on different servers. Though it is not normally required to know which server is serving the master
role for a given model, this information is available in the JMX Console.

1. Open a web browser and go to http://<server>:<port>/jmx-console

Where:

<server> is the IP address or hostname of your Spectrum™ Technology Platform server.

<port> is the HTTP port used by Spectrum™ Technology Platform. The default is 8080.

2. Log in using the admin account.
3. Scroll down to Domain: org.neo4j. There will be a set of objects for each model, numbered,

starting at 0. The Role attribute in the HighAvailability object indicates whether this server is the
master for this model, and the Kernel object indicates the model name in the StoreDirectory
attribute.
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Clustered Architecture for the Global Geocoding Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing can
be used to support high availability and scaling. The deployment architecture includes a load balancer,
Spectrum™ Technology Platform nodes with Global Geocoding Modules and Geocoding databases.

Each Geocoding database MUST be installed in the same location on all of the nodes for
the cluster to work properly. For example, if the Geocoding database for “Spectrum Node

Note:

1” is installed on C:\data\, then the other Spectrum nodes' Geocoding database must also
reside on C:\data\.

ClusteredArchitecture for the Location IntelligenceModule

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing can
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be used to support high availability and scaling. The deployment architecture includes a load balancer,
a Spectrum Spatial cluster, a database, and a file share. With this approach it is possible to scale
both horizontally and vertically. You can cluster the Location Intelligence Module with or without
platform clustering, starting from version 8.0.

Load Balancer

The load balancer spreads requests between the Spectrum Spatial instances. Any load balancer
that supports load balancing HTTP/HTTPs requests can be used.

Spectrum Spatial Cluster

The cluster is a collection of Spectrum instances with LIM sharing administration, named resources,
geographical metadata content and configuration settings. Additional nodes can be added to the
cluster for resilience or to deliver support for greater loads. Each node can be scaled vertically
through additional hardware resources and/or additional instances should this be required for
hardware with massive resources. Spectrum can be configured to use restricted numbers of CPUs.

29Spectrum™ Technology Platform 10.0 SP1 Installation Guide

Cluster



Database

Spectrum stores named resources (maps, layers, tables and styles), geographic metadata and
configuration in a repository. In the default single server installation an embedded database is used
to store these resources on the local server. To create a resilient scalable solution this embedded
database should be replaced with a resilient independent database. Oracle, PostGreSQL/PostGIS
and Microsoft SQL Server are the supported repository databases.

In the load balanced configuration, Spectrum nodes cache these resources in a local cache and
search index in each node in the cluster. When a Spectrum node receives a request it uses the
local cache and index to find resources. Named resources can be added through any node in the
cluster. Each node keeps its cache current by checking for differences between its local cache and
the central database. This check occurs every 2 seconds by default. Time frequency can be
configured. This architecture ensures the server delivers high performance transactions and the
load on the repository database is kept to a minimum. If a new Spectrum node is added to the cluster
the cache and index are created automatically. Such a scenario can occur to remedy a node failure
or grow the capability of the deployment.

File Share

The file share provides a folder to hold map images generated by Spectrum. When maps are
rendered using the web services the server supports the map images being returned through URLs
or returned as a base 64 encoded image. When a URL is returned the map image is stored as a
file and served on request of the URL. To ensure any Spectrum node can return the map image a
file share is used to store the images.

Requirements

• All servers that host a node must have their system clocks synchronized in order for the cluster
to function. Verify that all systems point to the same time service to synchronize their clocks.

• All nodes in a cluster must be the same version of Spectrum™ Technology Platform so be sure
that the version you install is the same as the existing nodes.

• All nodes in a cluster must have the same modules installed, so be sure to install all the necessary
modules on the new node.

Installing a Cluster

If you are setting up a cluster for the Location Intelligence Module only, follow the instructions
in Installing a Cluster for the Location Intelligence Module on page 36.

Note:
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If you are setting up a cluster for the Data Hub Module, also see Installing a Cluster for
the Data Hub Module on page 35.

Note:

Installing a cluster involves setting up one Spectrum™ Technology Platform server at a time. Each
time you add a server you need to point it to an existing server which will act as a seed node. A
seed node is a server that has a copy of the Spectrum configuration data that it can copy to a new
node so that the new node's configuration is synchronized with the other nodes in the cluster. The
following diagrams illustrate this process.

After installing the first node you will in effect have a cluster with only one node:

When you install the second node it must point to the first node as a seed node. This will enable
the second node to receive a copy of the first node's configuration database, resulting in a cluster
with two nodes with synchronized configuration information.

As you add additional nodes, the new nodes can point to any of the existing nodes as a seed node.
You must also configure the first node to point to at least one other node in the cluster so that if it
is ever brought down it can rejoin the cluster.
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To install a cluster, follow these steps:

1. Install a load balancer. You can choose for yourself an appropriate load balancer. Follow the
procedures described in the load balancer's documentation when installing.

The load balancer must be configured to allow encoded forward slashes. If the load
balancer does not allow encoded forward slashes you may get HTTP 404 errors while

Note:

using the cluster. For example, if you are using an Apache load balancer, you can configure
it to allow encoded forward slashes by opening the httpd.conf file and specifying this
property: AllowEncodedSlashes On. For other types of load balancers, refer to the
load balancer's documentation.

2. Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 20.

3. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows task bar and select Stop Server.

4. Edit the file server/app/conf/spectrum-container.properties as follows:
spectrum.cluster.enabled

Set this to true.

spectrum.cluster.name

Set this to any name you want to give to the cluster. If you have multiple clusters,
give each cluster a unique name.

spectrum.cluster.address
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Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds

Set this to the IP address of the Spectrum™ Technology Platform server whose
configuration will be reproduced on new nodes added to the cluster. The new server
will be configured with the same settings as the seed server whenever it starts up so
that it is synchronized with the cluster.

If this is the first node in the cluster you need to specify a seed node that is not yet
running. If you know the IP address of the node you want to use as a seed node,
enter it now. Otherwise, you will need to return to this properties file once you have
the IP address of the seed node.

You can specify multiple IP addresses by separating each with a comma. We
recommend that you specify multiple seed nodes so that if one is down others can
be used to allow the node to join the cluster. The node will attempt to access each
seed node in the order listed. If none of the seed nodes can be reached, the node
will not join the cluster.

spectrum.cluster.nodename

Optional. This property allows you to define a specific node name to associate with
the configuration database on this node. You should set this option if you plan on
manually copying the configuration database from one server to another, such as
copying the configuration database from a staging server to a production server. If
you do not specify this property, an internally-used node name will be automatically
generated by the system.

5. Uncomment the following lines:

spectrum.runtime.hostname=
spectrum.runtime.port=

Modify these to point to the load balancer host name and the port on which you have configured
the load balancer to listen.

6. Save and close the spectrum-container.properties file.
7. Start the server. To start the server, right-click the Spectrum™ Technology Platform icon in the

Windows task bar and select Start Server.

Add additional nodes to the cluster. For instructions on adding a node, see Adding a Node to a
Cluster on page 34.
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Adding a Node to a Cluster

Follow this procedure if you have already set up a cluster with a load balancer and at least one
Spectrum™ Technology Platform node, and you want to add a new Spectrum™ Technology Platform
node.

1. Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see the Spectrum™ Technology Platform Installation Guide.

2. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows task bar and select Stop Server.

3. Edit the file server/app/conf/spectrum-container.properties as follows:
spectrum.cluster.enabled

Set this to true.

spectrum.cluster.name

Set this to the name of the cluster that you want this node to join.

spectrum.cluster.address

Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds

Set this to the IP address of the Spectrum™ Technology Platform server whose
configuration will be replicated on the new node.

You can specify multiple IP addresses by separating each with a comma. We
recommend that you specify multiple seed nodes so that if one is down others can
be used to allow the node to join the cluster. The node will attempt to access each
seed node in the order listed. If none of the seed nodes can be reached, the node
will not join the cluster.

4. Uncomment the following lines:

spectrum.runtime.hostname=
spectrum.runtime.port=

Modify these to point to the load balancer host name and the port on which you have configured
the load balancer to listen.

5. Save and close the spectrum-container.properties file.
6. Start the server.

• On Unix or Linux, change the working directory to the Spectrum™ Technology Platform server's
bin directory, source the setup file, then type the following command: ./server.start .
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• On Windows, right-click the Spectrum™ Technology Platform icon in the Windows task bar and
select Start Server.

Installing a Cluster for the Data Hub Module

1. Follow the directions in Installing a Cluster on page 30.
2. Stop all the Spectrum™ Technology Platform servers in the cluster. To stop the servers, right-click

the Spectrum™ Technology Platform icon in the Windows task bar and select Stop Server.
Alternatively, you can use the Windows Services control panel and stop the Pitney Bowes
Spectrum™ Technology Platform service.

3. Configure the property files.
4. Start the Spectrum™ Technology Platform server. To start the server, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Start Server. Alternatively, you
can use the Windows Services control panel to start the Pitney Bowes Spectrum™ Technology
Platform service.

Configuring Property Files

Two files are used to configure the Data Hub Module:

• SpectrumFolder\server\modules\hub\hub.properties-Controls Spectrum™Technology
Platform settings, including whether to join a cluster and whether to enable history tracking and
auditing.

• SpectrumFolder\server\modules\hub\db\neo4j.properties-Controls how the graph
databases are configured, using Neo4j Enterprise. This file is used as a template for each model.
If needed, each model can be configured separately by placing a copy of this property file into the
store directory for that model.

By default, each model is placed in a subdirectory under the
SpectrumFolder\server\modules\hub\db directory. The name of each model contains a
"model." prefix followed by the name of the model (e.g., "model.CustomerRetention"). The location
of this top-level directory may be overridden using the hub.models.path.base property in the
hub.properties file.

To configure the system to run in a cluster you must set the following properties in the hub.properties
file:

#hub.neo4j.database.type=embedded
hub.neo4j.database.type=ha

#For ha mode, MUST be set to the number of servers in the cluster (or
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models will not replicate reliably)
hub.servers.per.cluster=3

Note that the hub.servers.per.cluster property must match the number of servers expected in a
cluster. If fewer than this number of servers are running at the time the Data Hub attempts to open
or create a model, it will wait for these servers to join and then fail after a timeout. Once the model
is running, the system will continue running as long a quorum of servers (more than half the expected
number of servers) are in communication. For a cluster of six servers, four must stay in
communication, for three servers, two must stay in contact, and for a two-server cluster, all servers
must be in contact at all times. For this reason, it is recommended that clusters have a minimum of
three servers in order to achieve a level of fault tolerance. Also, an odd number of servers provide
better resiliency per server than an even-numbered cluster (e.g., both a three-server cluster and a
four-server cluster can withstand a maximum of one lost server).

Installing a Cluster for the Location Intelligence Module

To set up a cluster for the Location Intelligence Module, you must first configure a common repository
(depending on the type of database you have) then configure your system to prepare it for clustering.

Configuring a Common Repository

You must configure Spectrum to use a common repository database for the cluster. This ensures
that named resources, geographic metadata and configuration settings are managed across the
cluster. You can configure Spectrum to use a common repository database using a PostgreSQL,
an Oracle, or a Microsoft SQL Server database.

The repository is installed with a set of named resources, geographic metadata and configuration
files. To migrate these resources to the common database repository the resources need to be
exported from the default internal repository database and reimported into the new shared repository
database.

To provide support for bulk export/import of repository content, the repository provides a WebDAV
interface.

Set Up a PostgreSQL Repository Database

These steps describe how to set up your repository on a PostgreSQL database:

1. Copy all repository resources to a local folder using WebDAV.
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The contents of the installed repository must be exported. This step only needs to be performed
once, as the contents of the repository should be the same at this point for all instances of
Spectrum™ Technology Platform.

2. Back up the folder /<spectrum root>/server/modules/spatial/jackrabbit to a local directory or disk.
3. Stop Spectrum.
4. On all instances of Spectrum™ Technology Platform, add the database JDBC drivers to the

Spectrum common lib directory to allow it to use the selected database.

Copy the /<spectrum root>/server/modules/spatial/lib/postgresql-x.x-xxx.jdbc4.jar file to /<spectrum
root>/server/app/lib/postgresql-x.x-xxx.jdbc4.jar.

5. On all instances of Spectrum™ Technology Platform, edit the /<spectrum
root>/server/modules/spatial/jackrabbit/repository.xml file to point the repository to a database
and add clustering. There are four separate changes you need to make:
a) Modify the two FileSystem sections within the Repository and Workspace sections of the file:

<FileSystem class="org.apache.jackrabbit.core.fs.db.DbFileSystem">
<param name="driver" value="org.postgresql.Driver"/>
<param name="url"

value="jdbc:postgresql://<hostname>:<port>/<databasename>"/>
<param name="schema" value="postgresql"/>
<param name="user" value="<user>"/>
<param name="password" value="<pwd>"/>
<param name="schemaObjectPrefix" value="rep_"/>
</FileSystem>

b) Modify the Persistence Manager section within the Workspace section:

<PersistenceManager
class="org.apache.jackrabbit.core.persistence.bundle.PostgreSQLPersistenceManager">

<param name="url"
value="jdbc:postgresql://<hostname>:<port>/<databasename>"/>

<param name="schema" value="postgresql"/>
<param name="user" value="<user>"/>
<param name="password" value="<pwd>"/>
<param name="schemaObjectPrefix" value="${wsp.name}_"/>
<param name="externalBLOBs" value="false"/>
</PersistenceManager>

c) Enable Clustering at the end of the file, right above the </Repository> tag. Each instance of
Spectrum will need to have a distinct Cluster id to enable synchronization of clustering to work.
The delay defines the time delay for synchronization in milliseconds.

<Cluster id="node1" syncDelay="2000">
<Journal

class="org.apache.jackrabbit.core.journal.DatabaseJournal">
<param name="revision" value="${rep.home}/revision.log" />
<param name="driver" value="org.postgresql.Driver" />
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<param name="url"
value="jdbc:postgresql://<hostname>:<port>/<databasename>" />

<param name="schema" value="postgresql"/>
<param name="schemaObjectPrefix" value="rep_"/>
<param name="user" value="<user>"/>
<param name="password" value="<pwd>"/>
<param name="databaseType" value="postgresql"/>
</Journal>
</Cluster>

d) Comment out the DataStore section:

<DataStore class="org.apache.jackrabbit.core.data.FileDataStore"/>

6. On all instances of Spectrum™ Technology Platform, remove the following folders from the
/server/modules/spatial/jackrabbit directory: repository, version, workspaces.

7. If your PostgreSQL database has previously had repository content added, you must remove
tables from your database so a clean repository can be created. If you are starting with a new
database, make sure the tables do not exist. The following tables need to be removed from the
database:

public.default_names_id_seq
public.default_binval
public.default_bundle
public.default_names
public.default_refs
public rep_fsentry
public.rep_global_revision
public.rep_journal
public.rep_local_revisions
public.security_binval
public.security_bundle
public.security_names
public.security_refs

8. Start Spectrum.
9. Restore the resources by copying them from the local folder into the Repository using WebDAV.

Import the content of the repository you previously exported back into the repository. This step
only needs to be performed on one of the Spectrum™ Technology Platform instances.

Set Up an Oracle Repository Database

These steps describe how to set up your repository on an Oracle database:

1. Copy all repository resources to a local folder using WebDAV.
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The contents of the installed repository must be exported. This step only needs to be performed
once, as the contents of the repository should be the same at this point for all instances of
Spectrum™ Technology Platform.

2. Back up the folder /<spectrum root>/server/modules/spatial/jackrabbit to a local directory or disk.
3. Stop Spectrum.
4. On all instances of Spectrum™ Technology Platform, verify an Oracle JDBC Driver exists under

the folder <spectrum root>/server/app/lib (for example, ojdbc6-11.2.0.3.jar).
5. On all instances of Spectrum™ Technology Platform, edit the /<spectrum

root>/server/modules/spatial/jackrabbit/repository.xml file to point the repository to a database
and add clustering. There are four separate changes you need to make:
a) Modify the two FileSystem sections within the Repository and Workspace sections of the file:

<FileSystem class="org.apache.jackrabbit.core.fs.db.OracleFileSystem">

<param name="driver" value="oracle.jdbc.OracleDriver"
/>

<param name="url"
value="jdbc:oracle:thin:@//<hostname>:<port>/<databasename>" />

<param name="user" value="<user>" />
<param name="password" value="<pwd>" />
<param name="schema" value="oracle"/>
<param name="schemaObjectPrefix" value="rep_"/>

</FileSystem>

b) Modify the Persistence Manager section within the Workspace section:

<PersistenceManager
class="org.apache.jackrabbit.core.persistence.pool.OraclePersistenceManager">

<param name="driver" value="oracle.jdbc.OracleDriver"
/>

<param name="url"
value="jdbc:oracle:thin:@//<hostname>:<port>/<databasename>" />

<param name="user" value="<user>" />
<param name="password" value="<pwd>" />
<param name="schema" value="oracle"/>
<param name="schemaObjectPrefix" value="${wsp.name}_"/>

<param name="externalBLOBs" value="false"/>
</PersistenceManager>

c) Enable clustering at the end of the file, right above the </Repository> tag. Each instance of
Spectrum will need to have a distinct id to enable synchronization of clustering to work. The
delay defines the time delay for synchronization in milliseconds.

<Cluster id="node1" syncDelay="2000">
<Journal

class="org.apache.jackrabbit.core.journal.OracleDatabaseJournal">
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<param name="driver" value="oracle.jdbc.OracleDriver"
/>

<param name="url"
value="jdbc:oracle:thin:@//<hostname>:<port>/<databasename>" />

<param name="schema" value="oracle"/>
<param name="schemaObjectPrefix" value="rep_"/>

<param name="user" value="<user>" />
<param name="password" value="<pwd>" />
<param name="databaseType" value="oracle"/>
<param name="revision" value="${rep.home}/revision.log"

/>
</Journal>

</Cluster>

d) Comment out the DataStore section:

<DataStore class="org.apache.jackrabbit.core.data.FileDataStore"/>

6. On all instances of Spectrum™ Technology Platform, remove the following folders from the
/server/modules/spatial/jackrabbit directory: repository, version, workspaces.

7. If your Oracle database has previously had repository content added, you must remove tables
from your database so a clean repository can be created. If you are starting with a new database,
make sure the tables do not exist. The following tables need to be removed from the database:

default_names_id_seq
default_binval
default_bundle
default_names
default_refs
public rep_fsentry
rep_global_revision
rep_journal
rep_local_revisions
security_binval
security_bundle
security_names
security_refs

8. Start Spectrum.
9. Restore the resources by copying them from the local folder into the Repository using WebDAV.

Import the content of the repository you previously exported back into the repository. This step
only needs to be performed on one of the Spectrum™ Technology Platform instances.

Set Up an MS SQL Server Repository Database

These steps describe how to set up your repository on an MS SQL Server database:

1. Copy all repository resources to a local folder using WebDAV.
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The contents of the installed repository must be exported. This step only needs to be performed
once, as the contents of the repository should be the same at this point for all instances of
Spectrum™ Technology Platform.

2. Back up the folder /<spectrum root>/server/modules/spatial/jackrabbit to a local directory or disk.
3. Stop Spectrum on all nodes.
4. On all instances of Spectrum™ Technology Platform, add the database JDBC drivers to the

Spectrum common lib directory to allow it to use the selected database. Copy the /<spectrum
root>/server/modules/spatial/lib/sqljdbc4-4.x.jar file to /<spectrum
root>/server/app/lib/sqljdbc4-4.x.jar.

5. On all instances of Spectrum™ Technology Platform, edit the /<spectrum
root>/server/modules/spatial/jackrabbit/repository.xml file to point the repository to a database
and add clustering. There are four separate changes you need to make:
a) Modify the two FileSystem sections within the Repository and Workspace sections of the file:

<FileSystem class="org.apache.jackrabbit.core.fs.db.MSSqlFileSystem">

<param name="driver"
value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/>

<param name="url"
value="jdbc:sqlserver://${HOST}:${PORT};${DATABASENAME};"/>

<param name="schema" value="mssql"/>
<param name="user" value="${USERNAME}"/>
<param name="password" value="${PWD}"/>
<param name="schemaObjectPrefix" value="rep_"/>

</FileSystem>

b) Modify the Persistence Manager section within the Workspace section:

<PersistenceManager
class="org.apache.jackrabbit.core.persistence.pool.MSSqlPersistenceManager">

<param name="url"
value="jdbc:sqlserver://${HOST}:${PORT};${DATABASENAME};"/>
<param name="schema" value="mssql"/>
<param name="user" value="${USERNAME}"/>
<param name="password" value="${PWD}"/>
<param name="schemaObjectPrefix" value="${wsp.name}_"/>
<param name="externalBLOBs" value="false"/>
<param name="tableSpace" value=""/>
</PersistenceManager>

c) Enable clustering at the end of the file, right above the </Repository> tag. Each instance of
Spectrum will need to have a distinct id to enable synchronization of clustering to work. The
delay defines the time delay for synchronization in milliseconds.

<Cluster id="node1" syncDelay="2000">
<Journal

class="org.apache.jackrabbit.core.journal.MSSqlDatabaseJournal">
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<param name="revision" value="${rep.home}/revision.log" />
<param name="driver"
value="com.microsoft.sqlserver.jdbc.SQLServerDriver"/>
<param name="url"
value="jdbc:sqlserver://${HOST}:${PORT};${DATABASENAME};"/>
<param name="user" value="${USERNAME}"/>
<param name="password" value="$PWD}"/>
<param name="schema" value="mssql"/>
<param name="schemaObjectPrefix" value="rep_"/>
<param name="databaseType" value="mssql"/>

</Journal>
</Cluster>

d) Comment out the DataStore section:

<DataStore class="org.apache.jackrabbit.core.data.FileDataStore"/>

6. On all instances of Spectrum™ Technology Platform, remove the following folders from the
/server/modules/spatial/jackrabbit directory: repository, version, workspaces.

7. If your SQL Server database has previously had repository content added, you must remove
tables from your database so a clean repository can be created. If you are starting with a new
database, make sure the tables do not exist. The following tables need to be removed from the
database:

default_names_id_seq
default_binval
default_bundle
default_names
default_refs
public rep_fsentry
rep_global_revision
rep_journal
rep_local_revisions
security_binval
security_bundle
security_names
security_refs

8. Start Spectrum on all nodes.
9. Restore the resources by copying them from the local folder into the repository using WebDAV.

Import the content of the repository you previously exported back into the repository. This step
only needs to be performed on one of the Spectrum™ Technology Platform instances.
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Configuring Your System

Once the Spectrum™ Technology Platform is installed and you have configure a common repository,
you need to configure your instance before you can replicate it to another virtual machine. If you
are not using a virtual machine environment, you will need to perform these steps on each of your
Spectrum™ Technology Platform installations.

Adding a Map File Share

You can add a map file share (a shared image folder) to Spectrum™ Technology Platform. (To
create a map file share, see page 43.)

To add a map file share:

1. Modify the Mapping Service configuration by pointing to a shared image folder and load balance
server. In the ImageCache change the Directory parameter to a common image directory, and
change the AccessBaseURL parameter to the load balancer machine image URL.

If you are using a virtual machine environment, remember this IP address, as you must set the
load balancer VM to this IP address.

<ImageCache>
<Directory>/mnt/<linux mount>/images</Directory>
<AccessBaseURL>http://<loadbalance_IP_address>/Spatial/images</AccessBaseURL>

<FileExpire>30</FileExpire>
<ScanInterval>30</ScanInterval>
</ImageCache>

2. Set up symbolic link to enable map images to go to the shared file system.

cd /<spatial server root>/server/modules/spatial
rm –Rf images
ln -s / mnt/<linux mount>/images

Setting Up a Map Image File Share

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a shared
folder accessible to all Spectrum nodes. The file share is not required if maps are returned from the
web services as Base64-encoded images.

To set up a map image file share:
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1. Mount a shared folder on each operating system hosting Spectrum. The commands belowmount
a drive on a Microsoft Windows Server or network drive supporting CIFS.

mkdir /mnt/<linux mount>
mount -t cifs //<windows host>/<windows share> /mnt/<linux mount>-o
username=shareuser,password=sharepassword,domain=pbi

2. Set the image share to load at startup in /etc/fstab.

//<windows ip address for share>/share /path_to/mount cifs
username=server_user,password=secret,_netdev 0 0

Modifying the Service Configurations

To modify the service configurations for load balancing:

In each service configuration file, change the <RepositoryURL> to point to the load balance
server repository URL.
The RepositoryURL should change to point to the balancer from
http://<Spectrum>/RepositoryService/rmi to
http://<Balancer>/RepositoryService/rmi.

Modifying Java Properties File

To modify the java properties for Spectrum™ Technology Platform:

1. Modify the java.properties file, located in
<spectrum>/server/modules/spatial/java.properties, to point to the load balance
server.

2. Change the images.webapp.url and all of the service host and port numbers to point to the load
balance server.

Configuring Ports for Multiple Spectrum Instances

If you have multiple Spectrum™ Technology Platform instances on a single machine, you must
change the port numbers.

To change the port numbers for each Spectrum™ Technology Platform instance:

1. Change all ports in <Spectrum
root>/server/app/conf/spectrum-container.properties to new port values that are
not in use. The http port reflects the port number entered in the installer.

2. Update the rmi port in bootstrap.properties in the /<spectrum root>/server/modules/spatial folder
(for example, 11099). The default is 1099.
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Shared Spectrum Local Data

If you are using TAB file data on the file system, this data needs to be in a shared location accessible
by all instances of Spectrum in the load balanced environment. It is also important to note that all
named resources in the repository accessing data on the file system should point to this shared
location.

Each VM or machine hosting Spectrum needs to have access to the mounted shared drive.

Using named resources that point to database tables do not require a shared drive, as the
named resources in the repository do not access the data using a file path; rather they use
a named connection to the data in the database.

Note:

Upgrading a Cluster

Before upgrading, be sure to read the release notes for the new version. The release
notes contain important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

Important:

If you are upgrading a cluster for the Location Intelligence Module only, follow the instructions
in Upgrading with Clustering for the Location Intelligence Module on page 49. If you

Note:

are upgrading both Spectrum and LIM clusters, before shutting down all nodes also see
Upgrading with Clustering for the Location Intelligence Module on page 49 for some
required pre-upgrade steps.

If you are upgrading a cluster for the Data Hub Module, also seeUpgrading with Clustering
for the Data Hub Module on page 47 for some required pre- and post-upgrade steps.

Note:

1. Shut down all the Spectrum™ Technology Platform nodes in the cluster.
2. Choose which node you want to upgrade first, and upgrade that node. For instructions, see

Upgrading a Server on page 21.
3. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click

the Spectrum™ Technology Platform icon in the Windows task bar and select Stop Server.
4. Edit the file server/app/conf/spectrum-container.properties as follows:

spectrum.cluster.enabled

Set this to true.

spectrum.cluster.name

Set this to any name you want to give to the cluster. If you have multiple clusters,
give each cluster a unique name.

spectrum.cluster.address
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Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds

Set this to the IP address of the Spectrum™ Technology Platform server whose
configuration will be reproduced on new nodes added to the cluster. The new server
will be configured with the same settings as the seed server whenever it starts up so
that it is synchronized with the cluster.

If this is the first node in the cluster you need to specify a seed node that is not yet
running. If you know the IP address of the node you want to use as a seed node,
enter it now. Otherwise, you will need to return to this properties file once you have
the IP address of the seed node.

You can specify multiple IP addresses by separating each with a comma. We
recommend that you specify multiple seed nodes so that if one is down others can
be used to allow the node to join the cluster. The node will attempt to access each
seed node in the order listed. If none of the seed nodes can be reached, the node
will not join the cluster.

spectrum.cluster.nodename

Optional. This property allows you to define a specific node name to associate with
the configuration database on this node. You should set this option if you plan on
manually copying the configuration database from one server to another, such as
copying the configuration database from a staging server to a production server. If
you do not specify this property, an internally-used node name will be automatically
generated by the system.

5. Uncomment the following lines:

spectrum.runtime.hostname=
spectrum.runtime.port=

Modify these to point to the load balancer host name and the port on which you have configured
the load balancer to listen.

6. Save and close the spectrum-container.properties file.
7. Start the server.
8. Repeat this process to upgrade the other nodes in the cluster.
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Upgrading with Clustering for the Data Hub Module

Additional steps are required for the Data Hub Module both before and after the upgrade process.

Prepare for Upgrading

1. Follow the instructions in Upgrading a Cluster on page 45, as these apply to both clustered and
non-clustered environments.

2. Follow the instructions in "Backing up Data Hub Models" from the Master Data Management
Guide.

3. Shut down each server in the cluster. Shut the instances down one at a time rather than all at
once, and shut down the master server last. Because the choice of master depends upon which
server first opened the model, you may want to restart the cluster and open each model from the
first server that was started and then shut them down in reverse order.

4. To ensure that Spectrum™ Technology Platform is shut down cleanly and completely, examine
the SpectrumDirectory/server/app/repository/logs/wrapper.log file for errors
during shutdown.

5. For Spectrum™ Technology Platform versions 10.0 and later, each model directory must contain
a version.data file
(SpectrumDirectory/server/modules/hub/db/model.<modelname>/version.data).
If after opening each model on the master server the model directory does not contain this file,
it can be copied from one of the non-master nodes. This issue can occur when a non-master
services the initial request to create a model.

Upgrade the Master Server
After following the instructions in Upgrading a Cluster on page 45 to install the new version of
Spectrum™ Technology Platform on the master server, the server will have been reset to a
non-clustered configuration. The server can be started at this point; however, the Data Hub models
may still require a store upgrade and will fail to open if the server is started before the store upgrade
is allowed.

1. Stop the Spectrum™ Technology Platform server. To stop the server, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Stop Server. Alternatively, you
can use the Windows Services control panel and stop the Pitney Bowes Spectrum™ Technology
Platform service.

2. Confirm that master server is set to non-clustered (embedded) mode in the
SpectrumFolder\server\modules\hub\hub.properties file:

hub.neo4j.database.type=embedded
#hub.neo4j.database.type=ha

#For ha mode, MUST be set to the number of servers in the cluster (or
models will not replicate reliably)
#hub.servers.per.cluster=3
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3. Enable store upgrade by setting the following line from
SpectrumFolder\server\modules\hub\db\neo4j.properties as shown below.

allow_store_upgrade=true

4. Start the Spectrum™ Technology Platform server. To start the server, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Start Server. Alternatively, you
can use the Windows Services control panel to start the Pitney Bowes Spectrum™ Technology
Platform service.

5. Open each model.
6. Follow the instructions in "Backing up Data Hub Models" from the Master Data Management

Guide again.
7. Stop the Spectrum™ Technology Platform server. To stop the server, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Stop Server. Alternatively, you
can use the Windows Services control panel and stop the Pitney Bowes Spectrum™ Technology
Platform service.

8. Set the master server to clustered (high-availability) mode in the
SpectrumFolder\server\modules\hub\hub.properties file:

#hub.neo4j.database.type=embedded
hub.neo4j.database.type=ha

#For ha mode, MUST be set to the number of servers in the cluster (or
models will not replicate reliably)
#hub.servers.per.cluster=3

9. Compare any configuration files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties that
old files do not.

Delete Models on Non-Master Servers
Before upgrading, delete the models in the SpectrumDirectory/server/modules/hub/db
directory for all non-master servers. Do not delete the models from the master server.

Upgrade Non-Master Servers

1. Follow the instructions in Upgrading a Server on page 21 for each non-master server. If the
installer starts up the Spectrum™ Technology Platform server, shut the server down.

Do not open any models in the cluster while you are upgrading.Note:

2. Set each non-master server to clustered (high-availability) mode in the
SpectrumFolder\server\modules\hub\hub.properties file:

#hub.neo4j.database.type=embedded
hub.neo4j.database.type=ha

#For ha mode, MUST be set to the number of servers in the cluster (or
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models will not replicate reliably)
#hub.servers.per.cluster=3

3. Compare any configuration files that you backed up to the installed files and make any necessary
changes. Do not overwrite new files with old files because new files may contain properties that
old files do not.

Copy Models

Copy the SpectrumFolder\server\modules\hub\db\model.* directories to each of the
non-master servers.

Start the Servers

1. Start up the master server, followed by non-master servers.
2. Ensure that each server in the cluster is functioning. Check

SpectrumFolder\server\app\repository\wrapper.log for any errors.
3. While directly connected to the master server (bypassing the load balancer), open each model,

one at a time, and inspect the wrapper.log file for errors.

Upgrading with Clustering for the Location Intelligence
Module

When a common repository database is used for clustering, these additional steps required before
and after the Spectrum™ Technology Platform upgrade process. Before the upgrade, you must
move to a local Derby database setup; after the upgrade, you then change back to the cluster setup
by pointing repository.xml to the external database.

1. Before upgrading Spectrum™ Technology Platform, back up the repository by following these
steps.
a) Select a node from the cluster.
b) Back up the repository content using WebDAV.
c) Back up repository.xml (under Spectrum\server\modules\spatial\jackrabbit).
d) Back up the JDBC driver jar file used by the database for the repository (for example,

postgresql-9.1-901.jdbc4.jar under Spectrum\server\app\lib).
e) Back up repository.xml from

Spectrum\server\app\tmp\RepositoryService.war-xxxxxxxx-contents\
webapp\WEB-INF\classes\org\apache\jackrabbit\core. If you cannot find this file,
you can extract it from RepositoryService.war under Spectrum\server\app\deploy.

2. Switch the common repository database to a local Derby database (temporarily, just for upgrade
purposes). Apply the following steps to all nodes in the cluster.
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a) Shut down the Spectrum™ Technology Platform server.
b) Rename the jackrabbit folder to "jackrabbit_cluster" (from

Spectrum\server\modules\spatial\jackrabbit to
Spectrum\server\modules\spatial\jackrabbit_cluster).

c) Create another jackrabbit folder in the same location.
d) Copy repository.xml (backed up in Step 1e) to the jackrabbit folder.
e) Start the Spectrum™ Technology Platform server
f) Copy all the repository files and folders (backed up in Step 1b) into the repository using

WebDAV.
g) Shut down the Spectrum™ Technology Platform server

3. Follow normal procedures to upgrade Spectrum™ Technology Platform to the new version.
4. After the Spectrum™ Technology Platform upgrade is complete, switch back to the common

repository database for all nodes in the cluster by following these steps.
a) First node only: Start the Spectrum™ Technology Platform server (if required) and back up

the content from the repository using WebDAV.
b) Shut down the Spectrum™ Technology Platform server.
c) Rename the jackrabbit folder to "jackrabbit_local" (from

Spectrum\server\modules\spatial\jackrabbit to
Spectrum\server\modules\spatial\jackrabbit_local).

d) Create another folder named "jackrabbit" in the same location.
e) Copy repository.xml (backed up in Step 1c) to the jackrabbit folder.
f) Copy the JDBC driver jar (backed up in Step 1d) to Spectrum\server\app\lib.
g) Start the Spectrum™ Technology Platform server.
h) First node only: Remove the existing content from the repository, then copy the content that

you backed up in Step 4a into the repository using WebDAV.
i) Repeat Steps 4b-4g for each additional node.
j) For each additional node, after copying repository.xml (backed up in Step 1c) to the jackrabbit

folder, verify that it has a distinct Cluster ID.

Removing a Node from a Cluster

To remove a node from a cluster, stop the Spectrum™ Technology Platform server.

• On Unix or Linux, change the working directory to the Spectrum™ Technology Platform server's
bin directory, source the setup file, then type the following command: ./server.stop .

• On Windows, right-click the Spectrum™ Technology Platform icon in the system tray and select
Stop Server.
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If you do not want the server to rejoin the cluster the next time it starts up, open the file
server/app/conf/spectrum-container.properties in a text editor and set
spectrum.cluster.enabled to false.

For Location Intelligence Module users: If you want to keep the node standalone and able to run
outside the cluster, copy back the original repository.xml file and remove the following folders from
the /server/modules/spatial/jackrabbit directory for each instance of Spectrum™

Technology Platform: repository, version, workspaces. Restart the server and import the repository
content.

Adding Modules to a Cluster

After installing a cluster you may decide to add additional modules. This procedure describes how
to add one or more modules to an existing cluster.

1. Shut down all the Spectrum™ Technology Platform nodes in the cluster.
2. Choose a node where you will first install the module. On that node, open the following file in a

text editor: server/app/conf/spectrum-container.properties.
3. Set spectrum.cluster.enabled to false.
4. Save and close the file.
5. Install the module or modules you want to add. For instructions, see the Spectrum™ Technology

Platform Installation Guide.
6. Start up the server.

The server starts up in standalone (non-clustered) mode.

7. Wait for the server to fully start up, then stop the server.
8. Open server/app/conf/spectrum-container.properties in a text editor and set

spectrum.cluster.enabled to true.
9. Save and close the file.
10. Start up the server.

You now have a cluster of one with the new module installed.

11. Start up each of the other nodes.
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Starting a Cluster

If all the nodes in a cluster are stopped, you must follow this procedure to start up the cluster safely
and avoid data loss.

1. Start the node that was shut down last.

The first node that you start must be the last node that was shut down. Starting up
another node first may result in loss of data such as job history and configuration

Warning:

settings. If you do not know which node was shut down last, look in each node's
wrapper log for the time stamp of the shutdown message. You can find the wrapper
log in: Spectrum Location\server\app\repository\logs\wrapper.log.

2. Wait for the Spectrum™ Technology Platform server to completely start up.

You can tell when the Spectrum™ Technology Platform server has completely started up by
looking in the wrapper log: Spectrum
Location\server\app\repository\logs\wrapper.log. The following message is
displayed when the server is completely started:

Pitney Bowes Spectrum(TM) Technology Platform (Version Version Number)
Started.

3. Start the other nodes in the cluster.

Be sure to wait for the first node to start up completely before starting additional
nodes. Starting up additional nodes before the first one is started may result in loss
of data.

Warning:

Shutting Down a Cluster

To shut down an entire cluster:

1. Shut down each Spectrum™ Technology Platform server in the cluster.

• On Unix or Linux, change the working directory to the Spectrum™ Technology Platform server's
bin directory, source the setup file, then type the following command: ./server.stop .

• On Windows, right-click the Spectrum™ Technology Platform icon in the Windows task bar and
select Stop Server.
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2. Make a note of which node was shut down last. You will need this information when starting up
the cluster.

When starting up the cluster, the first node you start up must be the last node that
was shut down.

Warning:

Using Client Tools with a Cluster

1. Launch the client tool (Management Console, Enterprise Designer, or Interactive Driver).
2. In the Server name field, enter the server name of the load balancer.
3. In the Port field, enter the port that you have configured the load balancer to listen on.

Input files, output files and database resources must be on a shared drive, or file server,
or some commonly-accessible location. Otherwise, all files must be loaded on each server

Note:

that hosts a Spectrum™ Technology Platform server and must be located in the same
path.

Once you have logged in you can use the client tool as normal. The actions you take will apply to
all Spectrum™ Technology Platform instances in the cluster where you are logged in.
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Installing a Cluster with a Separated Configuration
Database

This procedure creates two clusters: one for the server nodes and one for configuration database
nodes. The nodes in the server cluster point to the servers in the configuration database cluster for
their configuration data. The nodes in the configuration database cluster replicate their data between
each other.

The following diagram illustrates this installation scenario:

To install a separate database repository, you first install the configuration database on servers in
a cluster, then install the server on nodes in a separate cluster. At least one configuration database
must be running before you can install the server.

1. Place the Spectrum™ Technology Platform installer on the server where you want to install the
configuration database.

2. Double-click installdb.exe.
3. Follow the prompts to install the configuration database.
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4. After the installation is complete, the configuration database starts up automatically. Verify that
the configuration database is fully started before continuing by opening the log file <Spectrum
Installation Location>/server/app/repository/logs/wrapper.log and looking
for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform (Version
version build) Started

Do not continue until the configuration database has fully started up. If it fails to start
up, troubleshoot the issue before continuing. Also, do not attempt to stop the

Important:

configuration database until after it has fully started for the first time. Stopping the
configuration database before it performs an initial startup can cause your installation
to become unusable.

5. Stop the configuration database. To stop the configuration database, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Stop Server. Alternatively, you
can use the Windows Services control panel to stop the configuration database by stopping the
Spectrum Database service.

6. Edit the file server/app/conf/spectrum-container.properties as follows:
spectrum.cluster.name

• If this is the first node in the cluster, set this to any name you want to give to the
cluster. Be sure that the name is unique if you have multiple clusters.

• If you are adding a node to an existing cluster, set this to the name of the cluster
that you want this node to join.

spectrum.cluster.enabled

Set this to true.

spectrum.cluster.address

Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds

Set this to the IP address of the configuration database server you want to be used
to set up new configuration database nodes added to the cluster. The configuration
database from the seed server is copied to the node whenever it starts up so that it
is synchronized with the cluster.

If this is the first node in the cluster you may specify seed nodes that are
not yet running. If you know the IP addresses of the nodes you want to

Note:

use as seed nodes, you may enter those now. Otherwise, you will need
to return to this properties file once you have the IP addresses of the
seed nodes and enter them.

You can specify multiple comma-separated IP addresses. You should specify multiple
seed nodes so that if one is down others can be used to allow the node to join the
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cluster. The node will attempt to access each seed node in the order listed. If none
of the seed nodes can be reached, the node will not join the cluster.

7. Save and close the spectrum-container.properties file.
8. Start the configuration database. To start the configuration database, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Start Server. Alternatively, you
can use the Windows Services control panel to start the configuration database by starting the
Spectrum Database service.

9. Install the configuration database on additional servers as needed to complete the configuration
database cluster.

10. Install the server cluster. For instructions, see Installing a Cluster on page 30.

When installing each server select the Server only option in the installer and provide the
host and port of one or more of each of the configuration database server. You can find the

Important:

port in the file
InstallationLocation\server\app\conf\spectrum-container.properties.
The port is specified in the spectrum.orientdb.binary.port property.

Upgrading a Cluster with a Separated Configuration
Database

Before upgrading, be sure to read the release notes for the new version. The release
notes contain important compatibility information, supported upgrade paths, and
module-specific data backup recommendations.

Important:

This procedure describes how to upgrade Spectrum™ Technology Platformwhen you have separated
the configuration database from the server. To upgrade an environment that has a separated
configuration database, you first upgrade the configuration database cluster, then the server cluster.

1. Shut down all the nodes in the server cluster and then shut down all the nodes in the configuration
database cluster.

Make a note of the last node that you shut down in the configuration database cluster.
You must start up this node first after upgrading.

Note:

2. On the last node that you shut down in the configuration database cluster, execute
installdb.exe. The installer upgrades the configuration database.

The first node that you upgrade must be the last node that was shut down. This is
because on some operating systems the configuration database will start automatically

Warning:

at the end of the upgrade process. If the first node that starts up is not the last node
that was shut down, data such as job history and configuration settings may be lost.
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If you do not know which node was shut down last, look in each node's wrapper log
for the time stamp of the shutdown message. You can find the wrapper log in:
Spectrum Location\server\app\repository\logs\wrapper.log.

3. After the upgrade process finishes, wait for the server to start up, then stop the server.

You can see when the server has started up by opening the log file <Spectrum Installation
Location>\server\app\repository\logs\wrapper.log and looking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform Database
(Version version build) Started

Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation
to become unusable.

Important:

4. If your existing server cluster is version 10.0 you must run a conversion utility on the cluster
before upgrading. This is only necessary for version 10.0 clusters.

Before proceeding, note the following:

• In order to run this utility, each node in the cluster must have adequate disk space. The amount
of free disk space needed is three times the size of the
server/app/repository/store/databases folder. If necessary, add disk space to each
node before proceeding.

• The conversion process may take up to an hour if you have a large configuration database.

a) Shut down all the Spectrum™ Technology Platform nodes in the server cluster.
b) On one of the nodes, back up the following folder:

server/app/repository/store/databases

c) On the last node that was shut down in the cluster, right-click the following file and select Run
as administrator:
SpectrumFolder\server\bin\convert.db.bat

5. Configure clustering for the database cluster.
a) Edit the file server/app/conf/spectrum-container.properties as follows:

spectrum.cluster.name

• If this is the first node in the cluster, set this to any name you want to give to the
cluster. Be sure that the name is unique if you have multiple clusters.

• If you are adding a node to an existing cluster, set this to the name of the cluster
that you want this node to join.

spectrum.cluster.enabled

Set this to true.

spectrum.cluster.address
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Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds

Set this to the IP address of the configuration database server you want to be used
to set up new configuration database nodes added to the cluster. The configuration
database from the seed server is copied to the node whenever it starts up so that it
is synchronized with the cluster.

If this is the first node in the cluster you may specify seed nodes that are
not yet running. If you know the IP addresses of the nodes you want to

Note:

use as seed nodes, you may enter those now. Otherwise, you will need
to return to this properties file once you have the IP addresses of the
seed nodes and enter them.

You can specify multiple comma-separated IP addresses. You should specify multiple
seed nodes so that if one is down others can be used to allow the node to join the
cluster. The node will attempt to access each seed node in the order listed. If none
of the seed nodes can be reached, the node will not join the cluster.

b) Save and close the spectrum-container.properties file.
c) Start the last node that was shut down in the configuration database. To start the configuration

database, right-click the Spectrum™ Technology Platform icon in the Windows task bar and
select Start Server. Alternatively, you can use the Windows Services control panel to start
the configuration database by starting the Spectrum Database service.

The first node that you start must be the last node that was shut down. Starting
up another node first may result in loss of data such as job history and configuration

Warning:

settings. If you do not know which node was shut down last, look in each node's
wrapper log for the time stamp of the shutdownmessage. You can find the wrapper
log in:Spectrum Location\server\app\repository\logs\wrapper.log.

d) After the upgraded configuration database is fully started up, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start up each
of them.

6. Upgrade each node in the server cluster. For instructions, see dUpgrading a Cluster on page
45.

When installing each server select the Server only option in the installer and provide the
host and port of one or more of each of the configuration database server. You can find the

Important:

port in the file
InstallationLocation\server\app\conf\spectrum-container.properties.
The port is specified in the spectrum.orientdb.binary.port property.

Any job or subflow stored in the system during a server upgrade is marked as exposed to
provide the same behavior for those jobs and subflows as before the upgrade. Any job or

Note:

subflow that is exported prior to the upgrade will not be exposed. Therefore, when importing
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these jobs or subflows back into the system, you must manually expose the imported job or
subflow.

Converting from a Standard Installation to a Separated
Configuration Database

If you have an existing Spectrum™ Technology Platform installation and you want to take advantage
of the improved scalability of a separated configuration database, you can convert your existing
installation from one where the configuration database is part of the server to one where the
configuration database is in a separate cluster.

At a high level, this is the conversion process:

• Shut down your existing Spectrum™ Technology Platform installation.
• Set up the new configuration database cluster:

• Install the separate configuration database software on a new server.
• Copy your existing configuration database to the new server.
• Configure clustering and start up the configuration database cluster.

• Install the server-only cluster and start it up.

Follow the detailed steps below to convert a standard installation to a separated configuration
database.

1. (Optional) If you are upgrading to a new version as part of converting from a standard installation
to a separated configuration database, upgrade your existing server. For instructions, see
Upgrading a Server on page 21.

2. Shut down the server. If you have a clustered installation, shut down the cluster.
3. Install the configuration database to a new server.

a) Place the Spectrum™ Technology Platform installer on the machine where you want to install
the configuration database. This must be a different machine from the one where you have
your existing Spectrum™ Technology Platform server installed.

b) Double-click installdb.exe.
c) Follow the prompts to install the configuration database.
d) After the installation is complete, the configuration database starts up automatically. Verify

that the configuration database is fully started before continuing by opening the log file
<Spectrum Installation Location>/server/app/repository/logs/wrapper.log
and looking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform (Version
version build) Started
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Do not continue until the configuration database has fully started up. If it fails to
start up, troubleshoot the issue before continuing. Also, do not attempt to stop

Important:

the configuration database until after it has fully started for the first time. Stopping
the configuration database before it performs an initial startup can cause your
installation to become unusable.

e) Stop the configuration database. To stop the configuration database, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Stop Server. Alternatively, you
can use the Windows Services control panel to stop the configuration database by stopping
the Spectrum Database service.

f) Copy the server\app\repository\store folder from your existing server to the server
where you installed the separate configuration database. Replace the existing
server\app\repository\store folder.

g) If the server from which you copied the server\app\repository\store folder is version
10.0 or earlier you must run a conversion utility on the configuration database on the new
machine.

Before running the conversion utility note the following:

• In order to run this utility, the server must have adequate disk space. The amount of free
disk space needed is three times the size of the
server/app/repository/store/databases folder. If necessary, add disk space before
proceeding.

• The conversion process may take up to an hour if you have a large configuration database.

To run the conversion utility:

1. Back up the following folder: server/app/repository/store/databases
2. Right-click the following file and select Run as administrator:

SpectrumFolder\server\bin\convert.db.bat

h) Configure the cluster properties for the database cluster by editing the file
server/app/conf/spectrum-container.properties as follows:
spectrum.cluster.name

• If this is the first node in the cluster, set this to any name you want to give to the
cluster. Be sure that the name is unique if you have multiple clusters.

• If you are adding a node to an existing cluster, set this to the name of the cluster
that you want this node to join.

spectrum.cluster.enabled

Set this to true.

spectrum.cluster.address

Set this to the network interface to which you want this node to bind. Specify 0.0.0.0
if you want the node to bind to all network interfaces.

spectrum.cluster.seeds
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Set this to the IP address of the configuration database server you want to be used
to set up new configuration database nodes added to the cluster. The configuration
database from the seed server is copied to the node whenever it starts up so that it
is synchronized with the cluster.

If this is the first node in the cluster you may specify seed nodes that are
not yet running. If you know the IP addresses of the nodes you want to

Note:

use as seed nodes, you may enter those now. Otherwise, you will need
to return to this properties file once you have the IP addresses of the
seed nodes and enter them.

You can specify multiple comma-separated IP addresses. You should specify multiple
seed nodes so that if one is down others can be used to allow the node to join the
cluster. The node will attempt to access each seed node in the order listed. If none
of the seed nodes can be reached, the node will not join the cluster.

i) Save and close the spectrum-container.properties file.
j) Start the configuration database. To start the configuration database, right-click the Spectrum™

Technology Platform icon in the Windows task bar and select Start Server. Alternatively, you
can use the Windows Services control panel to start the configuration database by starting
the Spectrum Database service.

k) Install the configuration database on additional servers as needed to complete the configuration
database cluster.

4. Install the server.
a) (Optional) If you are upgrading to a new version and you want to use the same machine to

host the upgraded server as hosted the existing server, uninstall the existing server of
Spectrum™ Technology Platform.

b) Install the server cluster. For instructions, see Installing a Cluster on page 30.

When installing each server select the Server only option in the installer and provide the
host and port of one or more of the configuration database servers. You can find the port in

Important:

the file
InstallationLocation\server\app\conf\spectrum-container.properties.
The port is specified in the spectrum.orientdb.binary.port property.
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Converting from a Separated Configuration Database to
a Standard Installation

If you have a cluster that consists of separate clusters for the server and for the configuration
database, you can convert your installation to a standard installation where the server and
configuration database are installed together on the same server.

1. Shut down all the nodes in the server cluster and then shut down all the nodes in the configuration
database cluster.

2. The configuration database must be of the same version of Spectrum™ Technology Platform as
the server you are converting to. If the configuration database is from an older version, upgrade
the configuration database to the same version of Spectrum™ Technology Platform as the version
you want to use for the standard server. On the last node that you shut down in the configuration
database cluster, execute installdb.exe. The installer upgrades the configuration database.

The node that you upgrade must be the last node that was shut down. This is so that
data such as job history and configuration settings are not lost. If you do not know

Warning:

which node was shut down last, look in each node's wrapper log for the time stamp
of the shutdown message. You can find the wrapper log in: Spectrum
Location\server\app\repository\logs\wrapper.log.

3. After the upgrade process finishes, wait for the server to start up, then stop the server.

You can see when the server has stared up by opening the log file <Spectrum Installation
Location>\server\app\repository\logs\wrapper.log and looking for this message:

INFO [Server] Pitney Bowes Spectrum(TM) Technology Platform Database
(Version version build) Started

Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation
to become unusable.

Important:

4. Install a new server. For instructions, see Installing a New Server on page 20.

When prompted, be sure to select Standard Installation, not Server only.Note:

5. Stop the server.
6. Copy the SpectrumLocation/server/app/repository/store folder from the last

configuration database server you shut down to the new server, replacing the existing
SpectrumLocation/server/app/repository/store folder.

7. Start the server.
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5 - Spectrum
Databases
After you have installed the server you need to install the databases that
support themodule(s) you have installed. Databases provide the information
that Spectrum™ Technology Platform modules use to process data, such
as postal address data, name data, or geospatial data. For example, if you
have installed the Enterprise Geocoding Module, you will need to install
databases that contain geospatial data; if you have installed the Universal
Addressing Module, you will need to install databases that contain postal
data.

In this section

Installing the Address Now Module Database 65
Installing the Advanced Matching Module Database 65
Installing Data Normalization Module Databases 66
Installing Enterprise Geocoding Module Databases 68
Installing Enterprise Routing Module Databases 71
Installing Enterprise Tax Module Databases 71
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Installing the Global Sentry Module Database 78
Installing Location Intelligence Module Databases 80
Installing Universal Addressing Module Databases 80
Installing Universal Name Module Databases 82
Using the Database Silent Installer 84



Installing the Address Now Module Database

1. Copy the liclcs.sbi license file provided by Pitney Bowes into the following directory:
<SpectrumPlatformLocation>\server\modules\anow\license.

2. Make sure no applications are running.
3. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Stop Server.
4. Insert the database DVD containing the database(s) you want to install.

You must install the Postal databases if you want to use the Enhanced databases.Note:

5. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Address Now Module > Address Now Data Loader.

6. The installation wizard guides you through the rest of the process.

The installation location for the Address Now directory defaults to
<SpectrumPlatformLocation>\server\modules\anow. Do not change this path
or the database will not install correctly.

Note:

When prompted for the location of the Installation Media Directory, be sure to select the
directory on the database DVD that contains the kbase folder.

Note:

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

7. When the Data Loader is finished, start the Address Now server by going to Control Panel >
Administrative Tools > Services. Right-click the Address Now Server service and select Start.

8. After the database installed, start Spectrum™ Technology Platform. To do this, right-click the
Spectrum™ Technology Platform icon in the Windows task bar and select Start Server.

Installing the Advanced Matching Module Database

The Advanced Matching Module provides a load utility to install databases. The database files that
you install depend on the databases you have licensed.

To install the Advanced Matching Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
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2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the technical support web site,
www.g1.com/support.

If you download the database from the web site, it will be downloaded as a zip file. Unzip
the database before proceeding with the installation.

Note:

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. Open the file <SpectrumDirectory>\server\bin\wrapper\wrapper.conf in a text
editor.

7. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum
heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

8. Save and close wrapper.conf.
9. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Start Server.

Installing Data Normalization Module Databases

The Data Normalization Module provides a load utility to install databases for the Advanced
Transformer, Open Parser, and Table Lookup components. The database files that you install
depend on the databases you have licensed. Use this list of database tables to determine which
files you should download and install. For more information on the tables contained in each database,
refer to the reference documentation for each component.
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Available DatabasesStage

Data Normalization Module - Base TablesAdvanced Transformer

Open Parser
• Data Normalization Module - Base Tables
• Core Names Database
• Company Names Database
• Arabic Plus Pack
• Asian Plus Pack

Table Lookup
• Data Normalization Module - Base Tables
• Core Names Database
• Arabic Plus Pack
• Asian Plus Pack
• ZREPLACE (Used by the SAPModule for French address
validation)

To install the Data Normalization Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Stop Server.
3. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the web site, it will be downloaded as a zip file. Unzip
the database before proceeding with the installation.

Note:

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Data Normalization Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.
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Installing Enterprise Geocoding Module Databases

This module has several databases. You may have one or more of these, depending on the features
you have licensed.

International Geocoding Databases

International geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S. Each country has its own database, and some countries
have optional databases that provide enhanced geocoding.

If you install multiple databases, install each database to a separate folder.Note:

To install the Enterprise Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in the

release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run dbloader.exe.
5. Follow the prompts during the rest of the installation process.

Do not install geocoding databases on a network drive. Doing so can cause performance
problems.

Note:

6. After you install the database files, use the Database Resource tool in the Management Console
to define the database as a resource. For more information, see the Administration Guide.

If you installed the Australia Geocoded National Address File (G-NAF), you must specify the
GNAF123 and GNAF456 as separate paths but in the same database resource in the
Management Console.

Note:

If you install the Australia Geocoded National Address File (G-NAF), there will be two subfolders:
GNAF123 and GNAF456. GNAF123 contains the point-level dictionary. This has the highest precision
of geocoding (characterized by Reliability Level 1, 2, or 3.) GNAF456 contains the remainder of
address information in G-NAF that does not meet high precision geocoding criteria (characterized
by Reliability Level 4, 5, or 6.) We recommend that you use both databases to validate the existence
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of addresses but only use GNAF123 for parcel-level geocoding. If you do not require parcel-level
geocodes you can use GNAF456 for geocoding.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

• Centrus Enhanced Geocoding—This database consists of TIGER data provided by the U.S.
Geological Survey and address data provided by the U.S. Postal Service.

• TomTomGeocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. The data is provided by TomTom, a
third-party provider of spatial data, and postal data from the U.S. Postal Service.

• NAVTEQGeocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. NAVTEQ data is provided by NAVTEQ, a
third-party provider of spatial data. For more information about these databases, contact your
sales representative.

• ZIP + 4 Centroid—This database provides only address standardization and ZIP + 4 centroid
matching. It does not provide street-level matching.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the
Statewide Intersection Index will allow the database to search for "1st and Main St, CO" and return
a list of possible matches in Colorado more quickly than searching the entire geocoding database
for each instance of the intersection.

To install the Enterprise Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in the

release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

5. After you install the database files, use the Database Resource tool in the Management Console
to define the database as a resource. For more information, see the Administration Guide.
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Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides enhanced
geocoding accuracy for internet mapping, property and casualty insurance, telecommunications,
utilities, and others.

• Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

• Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

• Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

• Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

• Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

• TomTom Points Database—The data in this database is provided by TomTom, a third-party
provider of spatial data.

• NAVTEQ Points—This database is provided by NAVTEQ, a third-party data provider. It contains
data used to locate addresses at the center of the actual building footprint or parcel.

To install the Enterprise Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the Pitney Bowes web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

3. Run Setup.exe. The installation wizard guides you through the rest of the process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

4. After you install the database files, use the Database Resource tool in the Management Console
to define the database as a resource. For more information, see Spectrum™ Technology Platform
Administration Guide.
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Early Warning System (U.S. Only)

The USPS provides free Early Warning System (EWS) data to prevent matching errors due to the
age of the address information in the .gsd files. The USPS creates a new EWS data set each week
that you can download from the USPS website (ribbs.usps.gov).

To install the Early Warning System (EWS) database rename the database file fromOUT to EWS.txt
and place it in the same folder as the primary database.

Installing Enterprise Routing Module Databases

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.

Note:

3. Run dbloader.exe.
4. Follow the prompts during the rest of the installation process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

Installing Enterprise Tax Module Databases

Depending on the features you have licensed, you need to install one or more of these databases.

Database Compatibility

The Enterprise Tax Module version 9.0 SP2 and later uses a different data format than previous
releases. You must download and install the GeoTAX/Enterprise Tax Premium database for use
in this version. The GeoTAX/Enterprise Tax Premium database is not compatible with any releases
prior to version 9.0 SP2.
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Downloading Database Files

Prior to downloading the data files: If you have previously installed database files, you
should back up those files and delete any copies of the .gdi, .gsd, gsi, .gsl,
.gsu, .gsz, .gsx, .z9, .dir, .las and .los files in the data install directory.

Note:

Downloading from the eStore

Use the link in your welcome email to download the zip file. Extract the files and make note of the
directory where you save the files.

Downloading from the Technical Support Web Site

Download the database from the technical support web site, www.g1.com/support. The data file
will be downloaded as a .zip file. Extract the files and make note of the directory where you save
the files.

Downloading Florida Format Files

You can obtain the Florida format files from the Florida Department of Revenue. The Florida
Department of Revenue compiles the database based on county.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx/.

2. Unzip the downloaded files and transfer them to the server.

Be sure to FTP your files in binary format.Note:

3. Combine the county files into a single file if you downloaded more than one county. If you
downloaded the entire state list, you have approximately 67 files. You must combine all the files
into one file.
Your file is ready for loading.

Downloading TS-158 Format Files

The Federation of Tax Administrators (FTA) maintains a website with links to all data sources that
use the TS-158 format.

1. Download the files from the Florida website at:
https://pointmatch.state.fl.us/General/AddressFiles.aspx.

2. Unzip the downloaded files and transfer them to the Spectrum™ Technology Platform server.
3. State files are often broken up into individual county files. Combine all state and/or county files

into a single file.
Your file is ready for loading.
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Database Options

The following describes the database options presented in the Windows Database Load Utility.

GeoTAX master files
The GeoTAX/Enterprise Tax Premium Database is a required dataset and is the
master file for the Enterprise Tax Module software. The master files identify all
geographic components associated with a street address, such as the
latitude/longitude, census tract, and block group.

Point Data files
Point Data products include Master Location Data (MLD), Centrus Points, Centrus
NAVTEQ Points, and Centrus TomTom Points. The point data provides point-level
geocoding for the most accurate placement of addresses throughout the U.S. The
Master Location Data database provides the best available address point location
for every mailable and deliverable address in the United States.

User auxiliary file
This is a user-defined file that the Enterprise Tax Module uses to override results
from the master files in street-level matching. If you have data that is more current
than that in the master files, you can enter the new data into the auxiliary file and use
it for your address matching. The Enterprise Tax Module returns matches made with
a code that signifies the answer came from the auxiliary file. You can also return
user-defined data from the auxiliary file with the match. The install program creates
the file G1GTAUX in the specified destination.

GeoTAX auxiliary file
This file contains new addresses that have not yet been added to the master files. It
provides the most up-to-date address data possible. The install program creates the
indexed sequential file G1GTAX2 in the specified destination.

Landmark auxiliary file
This is a user-defined file that allows you to specify customized address information
in your input records. The recommended primary use of this file to match to your
company’s non-address locations such as well heads, transmission towers or any
other descriptive location. The latitude/longitude that is part of the input needed to
build this file allows companies to automatically keep track of any jurisdictional
changes that affect these unique locations. Matching to this file requires that the input
record information match exactly to the Landmark file contents. This also applies to
street records if you choose to enter them in the Landmark file. For more information,
refer to the Enterprise Tax Module Guide.

State-supplied Florida format file
This is a state-supplied file in Florida-native format which is provided by individual
state governments. The Enterprise Tax Module first attempts to match to the state
database. If the Enterprise Tax Module cannot find a state match, it attempts a match
to the GeoTAX Auxiliary file, if loaded, then to the master files.
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State-supplied TS-158 format file
This is a state-supplied file in TS-158 (ANSI Transaction Set No. 158) format which
is provided by individual state governments. The Enterprise Tax Module first attempts
to match to the state database. If the Enterprise Tax Module cannot find a state
match, it attempts a match to the GeoTAX Auxiliary file, if loaded, then to the master
files.

Boundary file
Boundary files provide additional data about locations of special tax districts:

• Special Purpose Tax Districts (spd.txb)
• Insurance Premium Tax Districts (ipd.txb)
• Payroll Tax Districts (pay.txb)
• Personal Property Tax Districts (ptd.txb)
• User-defined Boundary file (usr.txb)

PB Software tax rate file
The Pitney Bowes Software Sales and Use Tax Rate file allows you to use the
Enterprise Tax Module to provide sales and use tax rates for each of the assigned
tax jurisdictions as well as the total rate for the assigned locations. The install program
creates the indexed sequential file GTTAXRT.

Payroll tax correspondence file
Payroll tax cross-reference file allow you to use third-party software to determine the
payroll tax rates. The cross-reference files combine the U.S. Government Federal
Information Processing Standards (FIPS) codes with the proprietary geocodes used
by tax software from third parties. The Payroll System Tax Code file is a customized
file that you build to return the payroll tax codes used by your payroll system. The
install program produces database files called G1GTPTC and G1GTPTC.vix.

Taxware® cross reference file
This sales tax cross-reference file enables you to use the Enterprise Tax Module to
determine tax jurisdictions for a given address, then use Taxware® software to
determine the sales tax rates for those jurisdictions.

Vertex® cross reference file
This sales tax cross-reference files allows you to use the Enterprise Tax module to
determine tax jurisdictions for a given address, then use Vertex® software to determine
the sales tax rates for those jurisdictions.

PB Software Vertex® cross reference file
This is a Vertex® cross-reference file supplied by Pitney Bowes. The install program
produces a database file GTMSTR2 in the specified destination.
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Installing the Database Files

1. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Enterprise Tax Module > Database Load Utility.
The Database Load Utility window launches.

2. Select the database you want to install.

For Point Data, select the GeoTAX master files option.Note:

3. Follow the instructions provided by the wizard.

When specifying the destination directory:Note:

• All Enterprise Tax Module databases and cross-reference files must be installed in the
same directory.

• You may install databases on a mapped drive, but performance will be affected since
you will be accessing them on a network rather than accessing them locally.

4. In Management Console, open the Enterprise Tax Module database resource tool and define a
database resource that includes the database you just installed. Be sure to update Assign GeoTAX
Info and Reverse GeoTAX Info Lookup to use the new database resource.

Installing Global Geocoding Module Databases

This module supports databases for both US and non-US countries.

Non-US Geocoding Databases

Non-US geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S.

If you install multiple databases, install each database to a separate folder.Note:

To install the Global Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
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2. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run dbloader.exe.
5. Follow the prompts during the rest of the installation process.

Do not install geocoding databases on a network drive. Doing so can cause performance
problems.

Note:

6. After you install the database files, use either the Database Resource tool in the Management
Console or the Global Geocode CLI database commands to define the database as a resource.
For more information, see the Administration Guide.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

• TomTom Geocoding—This database provides street segment data by TomTom, a third-party
provider of spatial data, and postal data from the U.S. Postal Service.

• NAVTEQ Geocoding—This database provides street segment data by NAVTEQ, a third-party
provider of spatial data.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the
Statewide Intersection Index will allow the database to search for "1st and Main St, CO" and return
a list of possible matches in Colorado more quickly than searching the entire geocoding database
for each instance of the intersection.

To install the Global Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in the

release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.
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You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

5. After you install the database files, use either the Global Geocoding Database Resource tool in
the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides enhanced
geocoding accuracy for internet mapping, property and casualty insurance, telecommunications,
utilities, and others.

To use a points database, you must also install a streets database. See U.S. Geocoding
Databases on page 76 for the list of available US streets databases.

Note:

• Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

• Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

• Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

• Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

• Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

• TomTom Points—The data in this database is provided by TomTom, a third-party provider of
spatial data.

• NAVTEQ Points—This database is provided by NAVTEQ, a third-party data provider. It contains
data used to locate addresses at the center of the actual building footprint or parcel.

To install the Global Geocoding Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the Pitney Bowes web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

3. Run Setup.exe. The installation wizard guides you through the rest of the process.

77Spectrum™ Technology Platform 10.0 SP1 Installation Guide

Spectrum Databases

http://www.g1.com/support


You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

4. After you install the database files, use either the Global Geocoding Database Resource tool in
the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Installing the Global Sentry Module Database

The following databases are required to run Global Sentry in real-time mode:

• globalsentrydb.script
• globalsentrydb.properties

The following databases are required to run Global Sentry in batch mode:

• globalsentrydb.script
• globalsentrydb.properties
• globalsentrydb.addresses.csv
• globalsentrydb.fullnames.csv
• globalsentrydb.ids.csv
• globalsentrydb.names.csv

In addition, you must install the Data Normalization Module databases to use Global Sentry. For
instructions, see Installing Data Normalization Module Databases on page 66.

1. Open the Windows services control panel and stop the service Global Sentry Database Server.
2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Stop Server.
3. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the Pitney Bowes web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Global Sentry Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the Windows task bar and select Start Server.
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7. Open the Windows services control panel and start the service Global Sentry Database Server.
8. After installing the Global Sentry Module database, you must configure a JDBC connection in

the Spectrum™ Technology Platform Management Console. Go to Start > Settings > Control
Panel > Administrative Tools > Services to verify that the Global Sentry Database is running.

9. Open Management Console by clicking Start > Programs > Pitney Bowes > Spectrum™

Technology Platform > Client Tools > Management Console.
10. Under Resources, select JDBC Drivers.
11. Click Add.
12. Type the JDBC properties in the applicable text box:

• JDBC driver configuration name: HSQLDB
• JDBC driver class name: org.hsqldb.jdbcDriver
• Connection string template: jdbc:hsqldb:hsql://${host}:${port}/${instance}

13. Add the following driver file:
file:<SpectrumPlatformLocation>/GlobalSentryDatabase/lib/hsqldb.jar

14. Add the following Connection properties:
a) Click Add. In the JDBC Connection property dialog box, type "Password" in both the Label

and the Property Token fields and click OK.
b) Click Add. In the JDBC Connection property dialog box type "User" in the Label and the

Property Token fields and click OK.

15. Click OK.
16. Under Resources, click Connections.
17. Click Add.
18. Define the following connection properties:

• Connection name: Global Sentry
• Database driver: select the HSQLDB JDBC driver that you created in the previous steps.

19. Enter the following values in the Connection Properties dialog box:

• user: sa
• password: <there is no password>
• host: localhost or <your server name>
• port: 9001
• instance: globalsentrydb

20. Click Test to verify the connection works.
21. Click OK, then click OK again.
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Installing Location Intelligence Module Databases

1. Place the data on the file system, or install the data into a database.
2. Use Spatial Manager to define Location Intelligence Module database resources (named

connections and tables). For more information, see the "Configuring Database Resources" chapter
of the Spectrum™ Technology Platform Administration Guide on support.pb.com.

Installing Universal Addressing Module Databases

This procedure describes how to install databases used by Get Candidate Addresses, Get City
State Province, Get Postal Codes, Validate Address, and Validate Address AUS. For instructions
on installing databases used by Validate Address Global, see Installing Validate Address Global
Databases on page 81. For instructions on installing databases used by Validate Address Loqate,
see Installing Validate Address Loqate Databases on page 81.

To install the Universal Addressing Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in the

release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Addressing Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. If you choose to install Residential Delivery Indicator, an optional database that you license
directly from the U.S. Postal Service, you are prompted for the nine-digit RDI table and the
eleven-digit RDI table. These are called rts.hs9 and rts.hs11, respectively, and they are provided
by the U.S. Postal Service.
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Installing Validate Address Global Databases

This procedure describes how to install the databases used by the Validate Address Global stage.
For instructions on installing databases used by other Universal Addressing Module stages, see
the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Unzip the database file to the location you want. The database zip files are:

• VAGlobal-EMEA.zip—Contains the data for Europe, Middle East, and Africa.
• VAGlobal-APAC.zip—Contains the data for Asia-Pacific.
• VAGlobal-Americas.zip—Contains the data for the Americas.

You may install databases on a network share, but performance will be affected since
you will be accessing them on a network rather than accessing them locally.

Note:

4. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the system tray and select Stop Server.

5. Install the unlock code:
a) Open the following file in a text editor:

<SpectrumLocation>\server\modules\addressglobal\conf\unlockcodes.txt

b) Enter your unlock codes, one per line.
c) Save and close the file.

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform
icon in the system tray and select Start Server.

Installing Validate Address Loqate Databases

This procedure describes how to install the databases used by the Validate Address Loqate stage.
For instructions on installing databases used by other Universal Addressing Module stages, see
the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in the
release announcement or welcome email. You can also download the database from the technical
support web site, www.g1.com/support.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.
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3. Unzip the database file(s) to the location you want. If you are installing data from multiple zip
files or discs, be sure to unzip them all to the same location. The database zip files are:

• LQ0—Contains general database setup files.

Regardless of which set of data you use, the files in LQ0 must be installed.Note:

• LQ1—Contains the data for Middle East, Africa, and Asia-Pacific.
• LQ2—Contains the data for the Caribbean, Central America, and parts of South America.
• LQ3—Contains the data for Eastern and parts of Western Europe.
• LQ4—Contains the data for parts of North America.
• LQ5—Contains the data for parts of Western Europe.
• LQ6—Contains the data for parts of North America.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

4. From the location where you extracted the database files, right-click install.bat and select Run
as administrator. This will launch the Loqate Installer.

Except general database setup files (LQ0), all the other data files are placed inside the
DATA folder.

Note:

5. Follow the prompts during the rest of the installation process.
6. From the location where you installed the Loqate database, click InstallData.bat. This will launch

the Installation manager that installs the data files.

Installing Universal Name Module Databases

The Universal Name Module provides a load utility to install databases. The database files that you
load depend on the databases you have licensed.

To install the Universal Name Module databases on Windows Server 2008 you need
administrator privileges.

Note:

1. Make sure no applications are running.
2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Stop Server.
3. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

If you download the database from the web site, it will be downloaded as a zip file. Unzip
the database before proceeding with the installation.

Note:
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4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts to complete the installation process. The database files are you can install
are:

• Arabic Plus Pack: g1-cdq-cjki-arabic-<date>.jar
• Asian Plus Pack - Chinese: g1-cdq-cjki-chinese-<date>.jar
• Asian Plus Pack - Japanese: g1-cdq-cjki-japanese-<date>.jar
• Asian Plus Pack - Korean: g1-cdq-cjki-korean-<date>.jar
• Core Names Database: g1-cdq-nomino-base-<date>.jar

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. To load the complete Core Names Database, you must also install Open Parser and Table Lookup
data from the Data Normalization Module Database Load Utility.
a) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >Modules >

Data Normalization Module > Database Load Utility > Open Parser.
b) Follow the prompts to complete the installation process. The database file you need to install

is:

• cdq-OpenParser-EnhancedNames.tba

c) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >Modules >
Data Normalization Module > Database Load Utility > Table Lookup.

d) Follow the prompts to complete the installation process. The database file you need to install
is:

• cdq-TableLookup-EnhancedGenderCodes.tba

7. Open the file <SpectrumDirectory>\server\bin\wrapper\wrapper.conf in a text
editor.

8. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum
heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for the
Arabic Plus Pack and Asian Plus Pack.

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

9. Save and close wrapper.conf.
10. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology Platform

icon in the Windows task bar and select Start Server.
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Using the Database Silent Installer

The silent install process allows you to pre-configure the database installation process so that it
runs without user intervention. Instead of responding to prompts from the installation process for
information such as the installation location, you specify these responses in a properties file that
the installer uses instead of user prompts.

Using the Loqate Database Silent Installer

1. In the Spectrum™ Technology Platform server installer (not the database installer), browse to
the SilentInstaller folder.

2. Using a text editor, open the uam_loqate.installer.properties file.
3. Edit the properties file as necessary to specify the installation settings you want to use. See the

comments in the properties file for additional information.
4. To run the installer in silent mode, place the properties file in any directory except the location

where you are going to install the Loqate data and give the absolute path to the property in the
command prompt, as follows:

install.bat %PathOfPropertyFile%\uam_loqate.installer.properties
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6 - Client Tools

In this section

Installing the Client Tools 86
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Installing the Client Tools

The Spectrum™ Technology Platform client tools areWindows applications that you use to administer
your server and design and run dataflows and process flows. You must install your Spectrum™

Technology Platform server before installing the client tools.

Before installing, be sure to read the release notes. The release notes contains important compatibility
information as well as release-specific installation notes.

This procedure describes how to install the following client tools:

• Enterprise Designer— Use Enterprise Designer to create, modify, and run dataflows.
• Management Console—Use the Management Console to perform administrative tasks such as
setting service defaults, scheduling jobs, managing users and security, and so on.

• Interactive Driver—Use Interactive Driver to test different processing settings. Interactive Driver
allows you to run a small number of records through a process to preview the result.

• Job Executor—Job Executor is a command line tool that allows you to run a job from a command
line or script. The job must have been previously created and saved on Spectrum™ Technology
Platform using Enterprise Designer.

• Process Flow Executor—Process Flow Executor is a command line tool that allows the execution
of a process flow from a command line or script. The process flow must have been previously
created and saved on Spectrum™ Technology Platform using Enterprise Designer.

• Administration Utility—The Administration Utility provides command line access to several
administrative functions. You can use it in a script, allowing you to automate certain administrative
tasks. You can also use it interactively.

To install the client tools:

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.
3. Download the client tool you want to install.
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Installing Clients with a Silent Installer

The silent install process for the clients installs Management Console, Enterprise Designer, and
Interactive Driver without user intervention. Instead of prompting the user for information such as
the installation location, the installer uses pre-configured selections that you specify.

To use the silent installer you must first create an installer properties file by running the client installer
and responding to the prompts. The resulting properties file can then be used to silently install the
client on other computers.

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.
3. Click Download Installer.
4. Choose to save the file to a location on your computer.

Save the installer on a Windows computer that does not already have the client tools
installed. You will need to run the installer in order to specify the options you want to use
in the silent install process.

Note:

5. Open a Windows command prompt.
6. In the command prompt, change directories to the directory where you saved the installer.
7. Execute the following command:

Setup.exe -r installer.properties

8. Respond to the installer prompts by selecting the options that you want to use when the installer
runs silently.

For example, if you want the silent installer to install the client tools to
C:\SpectrumClientTools, specify C:\SpectrumClientTools when prompted for an
installation folder.

When the installer finishes running, a properties file named installer.properties is created
in the same folder as the Setup.exe file.

9. Open the installer.properties file in a text editor.
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10. Add the following on line 8 of the file:

INSTALLER_UI=silent

This is case sensitive to be sure to enter it exactly as shown above.Note:

11. Save and close the properties file.

You have now configured a properties file that will enable you to install the client tools silently.

12. To install the client tools silently, place installer.properties and Setup.exe in the same
folder on the computer where you want to install the client tools and run Setup.exe. When the
installer executes it will detect installer.properties and automatically run in silent mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

Setup.exe -f PathOfPropertyFile\installer.properties

Removing the Client Tools

1. Back up any files you may need in the future.
2. Use the Windows Add/Remove Programs control panel to uninstall the Spectrum™ Technology

Platform client tools or Client API.
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7 - Client API

In this section
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Installing the Client API

The Client API is used to integrate Spectrum™ Technology Platform functionality into your
applications. If you will be creating your own program to call Spectrum™ Technology Platform, you
need to install the Spectrum™ Technology Platform Client API on the system where you will be
developing your application. The Client API allows access to Spectrum™ Technology Platform
through several programming languages, including Java, C++, and web services.

1. Open the folder where you have downloaded the Spectrum™ Technology Platform Client API
installer.

2. Double-click the sdkinst.exe file.
3. The installer guides you through the installation process.

Removing the Client API

Use the Windows Add/Remove Programs control panel to uninstall the Spectrum™ Technology
Platform Client API.
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Configuring SAP

Integrating with SAP Web Dynpro

Before continuing verify the following:

• SAP Application, SAP NetWeaver 7.01 with Patch 3 and Spectrum™ Technology Platform is
available

• PBS SCA files have been deployed.
• System Landscape Directory (SLD) has been properly configured

To integrate Spectrum™ Technology Platform with SAP Web Dynpro, you need to install supporting
databases and dataflows on the Spectrum™ Technology Platform server, and then configure your
SAP system to communicate with Spectrum™ Technology Platform. Once you do this, users of SAP
Web Dynpro will have access to address validation and geocoding functionality from within SAP
Web Dynpro.

1. On the Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Required Name for Database ResourceDatabase

IGEO_CANEnterprise Geocoding Module - Canada Database

EGM_USEnterprise Geocoding Module - U.S. Database

ETMEnterprise Tax Module Database

CanadaUniversal Addressing Module - Canada Database

LoqateUniversal Addressing Module - Loqate Database

UAM_USUniversal Addressing Module - U.S. Database

2. When you install the SAPModule, several dataflow files are automatically installed. Other dataflow
files must be manually copied into Spectrum™ Technology Platform.
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a) If you are adding the Address Now Module, Enterprise Tax Module, or Universal Addressing
Module to an existing installation, open Spectrum™ Technology Platform Enterprise Designer,
select View > Server Explorer, and delete this dataflow: SAPValidateAddressWithCandidates.

b) Go to: SpectrumFolder\server\modules\dataflows\sap.
c) Review the following table then copy the applicable dataflow files to:

SpectrumFolder\server\app\import

Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPValidateAddressWithCandidates.ANOW.dfAddress Now Module

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidates.ANOW.df
SAPValidateAddressWithCandidates.UAM.df

Address Now Module
Universal Addressing Module

SAPValidateAddressWithCandidates.ANOW_EGM.dfAddress Now Module
Enterprise Geocoding Module

SAPValidateAddressWithCandidates.UAM_ANOW_EGM.dfAddress Now Module
Enterprise Geocoding Module
Universal Addressing Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Address Now Module
Enterprise Tax Module
Universal Addressing Module SAPGenerateCASSReport.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ANOW_ETM.df

SAPValidateAddressWithCandidates.UAM_ANOW_ETM_EGM.dfAddress Now Module
Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidate_UAM.df

Universal Addressing Module without
Loqate
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Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Universal Addressing Module without
Loqate
Enterprise Tax Module SAPGenerateCASSReport.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

ValidateAddressWithCandidates_UAM_Loqate.dfUniversal Addressing Module with
Loqate

ValidateAddressWithCandidates_UAM_Loqate_EGM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_Loqate.dfUniversal Addressing Module, Loqate
only

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module, Loqate
only
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_EGM.df

Enterprise Geocoding Module

ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ETM.df
SAPBatchAssignGeoTAXInfo.df

Enterprise Tax Module
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If errors occur in Management Console or Enterprise Designer, delete the contents of
<WindowsTemporaryDirectory>\g1Assemblies, where

Note:

<WindowsTemporaryDirectory> is one of the following: %TMP%, %TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C:\Documents and
Settings\<USERNAME>\Local Settings\Temp\g1Assemblies. After you delete the
contents of this folder log in again.

3. Import .SAR files.

A .SAR file is a file that contains a third-party add-on package for SAP, such as the Spectrum™

Technology Platform SAP Module. The .SAR file is located on the Spectrum™ Technology
Platform installer in the SAP Objects folder. For information on importing .SAR files into SAP
applications, see your SAP Basis administrator.

4. Activate the BC sets.
a) Log-on to the client where the settings for the Spectrum™ Technology Platform SAP Module

is to be configured.
b) Enter the transaction code SCPR20.

This activates Business Configuration (BC) sets. This will place the default entries on the
Spectrum™ Technology Platform customizing tables.

c) In the BC Set field, enter /HSGRP1/BCSET_BC_BAS_PV.
d) Activate it with the options Overwrite All Data and Default Mode.

e) Select and activate the remaining BC sets with the activation options set to Overwrite All
Data and Expert Mode.

Active these BC sets in the order listed.Note:

/HSGRP1/BCSET_BC_BAS_GTX
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/HSGRP1/MERGE_SETTINGS
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_VENDOR

5. Set up the RFC destination.
a) Enter transaction code SM59.
b) Click Create.
c) In the RFC Destination field, enter a name of your choice.
d) In the Connection Type field, enter G (HTTP connection to external server).
e) In the Description 1 field, enter a meaningful description.
f) Press the Enter key.
g) Click the Technical Settings tab.
h) In the Target Host field, enter the computer name or IP Address of the Spectrum™ Technology

Platform server.
i) In the Service No field enter 8080.
j) Click the Special Options tab.
k) Select No Timeout.
l) Select HTTP 1.1.
m) After you save, click Connection Test.

If there is a pop-up window, check the Accept All Further Cookies box and select
YES.

Note:

n) When the test is successful, go to theResponse Body tab to view the Spectrum™ Technology
Platform page.

6. Set up the Spectrum™ Technology Platform Logging Object
a) Enter transaction code SLG0.
b) Click New Entries.
c) In the Object column, enter /HSGRP1/DQC.
d) In the Object text column, enter DQC Logging.
e) Save the change.

7. Set up JCO destinations:
a) Go to the NetWeaver Portal Content Administrator URL and log in as J2EE_ADMIN or an

account that has an Administrator Privilege.
b) Expand Deployed Content, then pb.com, then pb.com/dqc. On the Details window, select

the JCO Connections tab.
c) SelectWD_DQC_MODELDATA_DEST and clickCreate. Complete all the required information

to be able to run and test the connection.
d) Repeat the steps and complete the required information for WD_DQC_MODELDATA_DEST.

96Spectrum™ Technology Platform 10.0 SP1 Installation Guide

SAP, Siebel, and Microsoft Dynamics



WD_DQC_MODELDATA_DEST is the Application Data and
WD_DQC_RFC_METADATA_DEST is the Dictionary Metadata.

Note:

8. Configure the BuildGlobalAddress web service in the SAP Visual Admin:
a) Go to <drive>:/usr./sap/<system id>/DVEBMGS01/ j2ee/admin and click go.bat and enter

J2EE_ADMIN password.
b) Go to Cluster > Server > Services > JCo RFC Provider and select the Bundles tab.
c) Enter all of the information needed by the application and click Set to save the changes.
d) Go to Cluster > Server > Services >Web Services Security.
e) Create a proxy in Web Services Client > sap.com > Dynamic WSProxies with the name

PBBIWebServiceConnectorBGA.
f) For the URL, enter:

http://<spectrumservername>:<port>/soap/BuildGlobalAddress?wsdl

For example,

http://MySpectrumServer:8080/soap/BuildGlobalAddress?wsdl

g) Restart the application server.

9. If you will be using French address validation, you must install the Data Normalization Module
table cdq-TableLookup-SAP.tba on the Spectrum™ Technology Platform server. For more
information, see the Spectrum™ Technology Platform Installation Guide.

Integrating with SAP Interaction Center WebClient

Before continuing verify the following:

• The Interaction Center WebClient user has the CRM_UI_PROFILE parameter ID with IC_AGENT
as the Parameter Value

• The duplicate option is activated in SPRO under ICWC (SPRO > CRM > ICWC > Define Account
Identification Profiles)

To integrate Spectrum™ Technology Platform with SAP Interaction Center WebClient, you need to
install supporting databases and dataflows on the Spectrum™ Technology Platform server, and
then configure your SAP system to communicate with Spectrum™ Technology Platform. Once you
do this, users of SAP Interaction Center WebClient will have access to address validation and
geocoding functionality from within SAP Interaction Center WebClient.

1. On the Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.
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Required Name for Database ResourceDatabase

IGEO_CANEnterprise Geocoding Module - Canada Database

EGM_USEnterprise Geocoding Module - U.S. Database

ETMEnterprise Tax Module Database

CanadaUniversal Addressing Module - Canada Database

LoqateUniversal Addressing Module - Loqate Database

UAM_USUniversal Addressing Module - U.S. Database

2. When you install the SAPModule, several dataflow files are automatically installed. Other dataflow
files must be manually copied into Spectrum™ Technology Platform.
a) If you are adding the Address Now Module, Enterprise Tax Module, or Universal Addressing

Module to an existing installation, open Spectrum™ Technology Platform Enterprise Designer,
select View > Server Explorer, and delete this dataflow: SAPValidateAddressWithCandidates.

b) Go to: SpectrumFolder\server\modules\dataflows\sap.
c) Review the following table then copy the applicable dataflow files to:

SpectrumFolder\server\app\import

Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPValidateAddressWithCandidates.ANOW.dfAddress Now Module

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidates.ANOW.df
SAPValidateAddressWithCandidates.UAM.df

Address Now Module
Universal Addressing Module

SAPValidateAddressWithCandidates.ANOW_EGM.dfAddress Now Module
Enterprise Geocoding Module

SAPValidateAddressWithCandidates.UAM_ANOW_EGM.dfAddress Now Module
Enterprise Geocoding Module
Universal Addressing Module
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Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Address Now Module
Enterprise Tax Module
Universal Addressing Module SAPGenerateCASSReport.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ANOW_ETM.df

SAPValidateAddressWithCandidates.UAM_ANOW_ETM_EGM.dfAddress Now Module
Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidate_UAM.df

Universal Addressing Module without
Loqate

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Universal Addressing Module without
Loqate
Enterprise Tax Module SAPGenerateCASSReport.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

ValidateAddressWithCandidates_UAM_Loqate.dfUniversal Addressing Module with
Loqate

ValidateAddressWithCandidates_UAM_Loqate_EGM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module
Enterprise Tax Module
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Copy these dataflow files to the import folderIf you are installing this set of
modules

ValidateAddressWithCandidates_Loqate.dfUniversal Addressing Module, Loqate
only

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module, Loqate
only
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_EGM.df

Enterprise Geocoding Module

ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ETM.df
SAPBatchAssignGeoTAXInfo.df

Enterprise Tax Module

If errors occur in Management Console or Enterprise Designer, delete the contents of
<WindowsTemporaryDirectory>\g1Assemblies, where

Note:

<WindowsTemporaryDirectory> is one of the following: %TMP%, %TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C:\Documents and
Settings\<USERNAME>\Local Settings\Temp\g1Assemblies. After you delete the
contents of this folder log in again.

3. Import .SAR files.

A .SAR file is a file that contains a third-party add-on package for SAP, such as the Spectrum™

Technology Platform SAP Module. The .SAR file is located on the Spectrum™ Technology
Platform installer in the SAP Objects folder. For information on importing .SAR files into SAP
applications, see your SAP Basis administrator.

4. Activate the BC sets.
a) Log-on to the client where the settings for the Spectrum™ Technology Platform SAP Module

is to be configured.
b) Enter the transaction code SCPR20.

This activates Business Configuration (BC) sets. This will place the default entries on the
Spectrum™ Technology Platform customizing tables.

c) In the BC Set field, enter /HSGRP1/BCSET_BC_BAS_PV.
d) Activate it with the options Overwrite All Data and Default Mode.
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e) Select and activate the remaining BC sets with the activation options set to Overwrite All
Data and Expert Mode.

Active these BC sets in the order listed.Note:

/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/MERGE_SETTINGS
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_VENDOR

5. Activate the following BC set with activation options set toOverwrite All Data and Expert Mode.

/HSGRP1/BCSET_DQC_CUSTOM

6. Activate the BC set for IC WebClient. The BC set is /HSGRP1/ICWC_SETTINGS. Specify the
activation options Overwrite Data and Expert Mode.

7. Set up the RFC destination.
a) Enter transaction code SM59.
b) Click Create.
c) In the RFC Destination field, enter a name of your choice.
d) In the Connection Type field, enter G (HTTP connection to external server).
e) In the Description 1 field, enter a meaningful description.
f) Press the Enter key.
g) Click the Technical Settings tab.
h) In the Target Host field, enter the computer name or IP Address of the Spectrum™ Technology

Platform server.
i) In the Service No field enter 8080.
j) Click the Special Options tab.
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k) Select No Timeout.
l) Select HTTP 1.1.
m) After you save, click Connection Test.

If there is a pop-up window, check the Accept All Further Cookies box and select
YES.

Note:

n) When the test is successful, go to theResponse Body tab to view the Spectrum™ Technology
Platform page.

8. Set up the Spectrum™ Technology Platform Logging Object
a) Enter transaction code SLG0.
b) Click New Entries.
c) In the Object column, enter /HSGRP1/DQC.
d) In the Object text column, enter DQC Logging.
e) Save the change.

9. Enable the Pitney Bowes IC WebClient Enhancement Set.
a) Enter the transaction code SM30.
b) In the Table/View field, enter BSPWDV_EHSET_ASG.
c) Click Maintain.
d) Click New Entries
e) In the Client field, enter the client number where the enhancement set will take effect.
f) In the Enhancement Set field, enter /HSGRP1/ENHANCEMENT_SET.

10. Add the IC WebClient Configurations.
a) Enter the transaction code BSP_WD_CMPWB.
b) In the Component field, enter ICCMP_DETAIL.
c) Click the check icon.
d) In the Enhancement Set field, enter /HSGRP1/ENHANCEMENT_SET.
e) Click Display.
f) Expand the Views folder and select

/HSGRP1/BUPA_CMP_VIEW/BuPaDetailSelectDuplCustomer.
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g) Click the Configuration tab.
h) On the edit screen select Full Name, Telephone, Street, City and Country context then click

the right arrow button and arrange them in this order:

Full Name
Telephone
Street
City
Country

i) Save the configuration.

11. If you will be using French address validation, you must install the Data Normalization Module
table cdq-TableLookup-SAP.tba on the Spectrum™ Technology Platform server. For more
information, see the Spectrum™ Technology Platform Installation Guide.

Installing Support Files for Read from SAP

The Read from SAP stage reads data from an SAP database as input to a Spectrum™ Technology
Platform dataflow. In order for the Read from SAP stage to access data in your SAP system you
must make the following changes on your SAP system:

• Install the SAP Java Connector
• Install the SAP Transport Requests that support Read from SAP

You will not be able to use the Read form SAP stage until you perform these steps.Note:

1. Install the SAP Java Connector (SAP JCo).
a) Go to service.sap.com/connectors and log in with your SAP Marketplace credentials.
b) Go to SAP JCo Connector > Tools & Services.
c) Download SAP JCo to your system.
d) Unzip the SAP JCo zip file to a temporary location.
e) Stop the Spectrum™ Technology Platform server.
f) Copy the .jar file to the following folder on the Spectrum™ Technology Platform server:

SpectrumFolder\server\app\lib

g) Copy the .dll file to the following folder on the Spectrum™ Technology Platform server:
SpectrumFolder\server\bin\wrapper

h) Start the Spectrum™ Technology Platform server.

2. Install the SAP Transport Requests that support Read from SAP.

The following steps should be performed by your SAP Basis administrator.Note:
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a) In the Spectrum™ Technology Platform installer, go to the folder AP Data Integration
Objects\Enterprise System Connectors.

b) Deploy the SAP Transport Requests contained in this folder. See your SAP documentation
for instructions on deploying SAP Transport Requests.

Configuring Siebel

Integrating with Siebel Data Quality

To integrate Spectrum™ Technology Platform with Siebel Data Quality, you need to install supporting
databases and dataflows on the Spectrum™ Technology Platform server, and then configure your
Siebel system to communicate with Spectrum™ Technology Platform. Once you do this, users of
Siebel Data Quality will have access to address validation and geocoding functionality from within
Siebel Data Quality.

1. On the Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Required Name for Database ResourceDatabase

IGEO_CANEnterprise Geocoding Module - Canada Database

EGM_USEnterprise Geocoding Module - U.S. Database

ETMEnterprise Tax Module Database

CanadaUniversal Addressing Module - Canada Database

LoqateUniversal Addressing Module - Loqate Database

UAM_USUniversal Addressing Module - U.S. Database

2. When you install the Siebel module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into the Spectrum™ Technology Platform server.
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a) Browse to one of the following folders on your Spectrum™ Technology Platform server:

• For Siebel Business Applications, go to:
<SpectrumPlatformLocation>\server\modules\dataflows\siebel\sea

• For Siebel Industry Applications, go to:
<SpectrumPlatformLocation>\server\modules\dataflows\siebel\sia

b) Review the following table then copy the applicable dataflow files to:

SpectrumLocation\server\app\import

Table 1: Dataflow Files To Import

Copy these dataflow files to the import folderIf you are installing this set of
modules

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.ADN.df

Address Now Module only

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_ADN.df

Address Now Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.EGM_ADN.df

Address Now Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_EGM_ADN.df

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates.UAM.df

Universal Addressing Module only

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates.UAM_EGM.df

Universal Addressing Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_UAM_ETM.df

Universal Addressing Module
Enterprise Tax Module
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Copy these dataflow files to the import folderIf you are installing this set of
modules

ValidateAddressWithCandidates_UAM_Loqate.dfUniversal Address Module with Loqate

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module, Loqate
only
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_Loqate.dfUniversal Addressing Module, Loqate
only

ValidateAddressWithCandidates.EGM.df
Enterprise Geocoding Module

ValidateAssignGeoTAXInfo.df
Enterprise Tax Module

If errors occur in Management Console or Enterprise Designer, delete the client cache.
To delete the client cache, go to Tools >Options in Management Console or Enterprise

Note:

Designer, click the Advanced tab, then click Clear Cache. After you clear the cache,
restart Management Console or Enterprise Designer.

3. Optional: If you are using the Enterprise Geocoding Module, configure the geocoding dataflow
to use the geocoding database resource name you have configured on your system:
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a) In Enterprise Designer, open the dataflow GeocodeUSAddressWithCandidates.
b) In each dataflow, open the Geocode US Address stage.
c) In the Database field, select the name of the geocoding database as defined in the

Management Console. The default name is KGDDatasource but if the geocoding database
has a different name on your system, select the appropriate name.

For more information about database resources, see the Spectrum™ Technology
Platform Administration Guide.

Note:

d) Save and close each dataflow.

4. Copy Siebel objects to your system:
a) Browse to the location where you downloaded the Spectrum™ Technology Platform installer.
b) Browse to the appropriate folder for your version of Siebel as shown in the following table.

FolderSiebel Version

Siebel Objects\8.0\Business\SDQSiebel Business Applications 8.0 SDQ

Siebel Objects\8.1.1\Business\SDQSiebel Business Applications 8.1.1 SDQ

Siebel Objects\8.0\Industry\SDQSiebel Industry Applications 8.0 SDQ

Siebel Objects\8.1.1\Industry\SDQSiebel Industry Applications 8.1.1 SDQ

c) Copy the contents of the folder to a temporary directory.

This temporary folder will be the referred to as <Spectrum Package> in the following
steps.

Note:

5. Create objects and allow object locking:
a) Log in to Siebel Tools as the user SADMIN. In the Connect to field select Server.
b) In the Object Explorer, click Project.
c) Create three new records using the following values in the Name column. To create a new

record, right-click in the Projects area and select New Record.

Group 1 Data Quality
Group 1 EAI Testing
Group 1 Workflow

d) Open the file <Spectrum Package>\tools\CDQP_Queries.txt.
e) Copy and paste the query contents to the Project list of your Object Manager. Cross-check

the query result with the table below and perform the action suggested. To toggle object
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locking, go to Object Explorer and browse to the Project object. From the Project area, right-click
and select the project, and select Toggle Object Locking.

Table 2: Queries for Siebel SDQ

ActionProjectSiebel Industry
Applications

Siebel Business
Applications

Toggle Object LockingAccountX

Toggle Object LockingAccount (SCW)X

Toggle Object LockingAccount (SSE)XX

Toggle Object LockingContactXX

Toggle Object LockingContact (SSE)

Toggle Object LockingCUT Account

Toggle Object LockingCUT Siebel
Communications

Toggle Object LockingCUT Usage

Toggle Object LockingDNB Data

Toggle Object LockingDeDuplication

Toggle Object LockingeAutomotive

Toggle Object LockingEmployeeXX

Toggle Object LockingFINS Contract

Toggle Object LockingFINS Contract Info

Toggle Object LockingFINS Deal Commercial

Toggle Object LockingFINS Financial Services

Toggle Object LockingFINS Opportunity
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ActionProjectSiebel Industry
Applications

Siebel Business
Applications

Create and Toggle Object
Locking

Group 1 Data QualityXX

Create and Toggle Object
Locking

Group 1 EAI TestingXX

Create and Toggle Object
Locking

Group 1 WorkflowXX

Toggle Object LockingList Mgmt (Import)

Toggle Object LockingList Mgmt (UI)XX

Toggle Object LockingMvg

Toggle Object LockingOppty

Toggle Object LockingOppty (SSE)

Toggle Object LockingPersonal ContactX

Toggle Object LockingPicklistXX

Toggle Object LockingServer Component
Requests

Toggle Object LockingSiebel Sales Enterprise

Toggle Object LockingSiebel Universal Agent

Toggle Object LockingVERT CUT AddressX

Toggle Object LockingVERT Cut Common

6. Check out the Siebel Projects:
a) Log in to Siebel Tools as the user SADMIN. In the Connect to field select Local.
b) Select Tools > Check Out.
c) Select the projects indicated in the following table and click Checkout.
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Table 3: Siebel Projects for SDQ

ProjectSiebel Industry ApplicationsSiebel Business Applications

AccountX

Account (SCW)XX

Account (SSE)XX

ContactXX

Contact (SSE)

CUT Account

CUT Siebel Communications

CUT Usage

DNB Data

DeDuplication

eAutomotive

EmployeeXX

FINS Contract

FINS Contract Info

FINS Deal Commercial

FINS Financial Services

FINS Opportunity

Group 1 Data Quality

Group 1 EAI TestingXX
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ProjectSiebel Industry ApplicationsSiebel Business Applications

Group 1 WorkflowXX

List Mgmt (Import)

List Mgmt (UI)XX

Mvg

Oppty

Oppty (SSE)

Personal ContactX

PicklistXX

Server Component Requests

Siebel Sales EnterpriseX

Siebel Universal Agent

VERT CUT AddressX

VERT Cut Common

7. Import the Spectrum™ Technology Platform Siebel Objects.
a) Select Tools > Import from Archive.
b) Browse to the Spectrum™ Technology Platform installation package. In the Siebel Objects

folder, browse to the subfolder for your version of Siebel and select the SIF files.
c) Select Merge the object definition in the repository and click Next.

8. Check in all locked projects:
a) Select Tools > Check In.
b) Select all the Projects to check in and click Check in.

9. (Open UI Only) Import the Spectrum™ Technology Platform Siebel Objects for Open UI:
a) Select Tools > Import from Archive.
b) Browse to the Spectrum™ Technology Platform installation package. In the Siebel Objects

folder, browse to the OPEN_UI subfolder for your version of Siebel and select the SIF files.
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c) Select Merge the object definition in the repository and click Next.

10. Compile all Projects:
a) Select Tools > Compile Projects.
b) Click All Projects.
c) In the Siebel Repository File field, enter the path of your Siebel Web Client SRF file.
d) Click Compile.

11. Deploy the Siebel objects in the client:

Keep a backup of the old SRF in case old binaries need to be re-implemented.Note:

a) Copy the generated SRF to your web client objects folder.

For example, on Windows the web client object folder may be C:\Program
Files\Siebel\8.0\web client\OBJECTS\ENU. On Unix or Linux the folder may be
/disk2/sia78/webclient/OBJECTS/enu/.

b) Copy the contents of <Spectrum Package>\dll to your BIN folder.
c) Copy the contents of <Spectrum Package>\cfg to your BIN/ENU folder.

12. Deploy the Siebel objects to the server:
a) Stop the Siebel server.
b) Copy the generated SRF file to your web client objects folder.

For example, the folder for Siebel Business on Windows may be
C:\sea80\siebsrvr\OBJECTS\ENU. On Unix or Linux the folder may be
/disk2/sea78/siebsrvr/OBJECTS/enu/.

c) Copy the libraries to your server.

• For Windows, copy the contents of <Spectrum Package>\lib\win to your BIN folder.
• For Unix or Linux, copy the contents of <Spectrum Package>/lib/sol to your LIB
folder.

d) Copy the contents of <Spectrum Package>\cfg to your BIN\ENU folder.
e) Start the Siebel server.

13. Install the options file.
a) Click Site Map > Administration - Data > LOV Explorer.
b) Click New.
c) In the Type column, enter FILE_PATH.
d) Click Query.
e) In the Type column, enter FILE_PATH.
f) Browse to the Values folder.
g) In the Display Value column, enter the absolute path to the folder where you want to keep

the options file. You can specify any folder you want.
h) Browse to the Spectrum™ Technology Platform installation package.
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i) In the Siebel Objects folder, browse to the cfg subfolder for your version of Siebel and
select the Group1Connector.opt file.

j) Copy this file to the folder you specified for FILE_PATH.

14. Activate the Spectrum™ Technology Platform workflows in the Siebel web client:
a) Log in to the Siebel Application, connecting to the server data source.
b) Select Site Map > Administration - Business Process >Workflow Deployment.
c) Query for all the GROUP 1* workflows.
d) Click Activate for each workflow.
e) Query for all the Promote* workflows.
f) ClickActivate for the ff workflowsPromote Prospect (Single) andPromote Prospect (Many).

15. Verify the installation:
a) Log in to Siebel Application.
b) All applets should load properly without error.

16. Configure the Siebel instance configuration parameters:
a) Select Site Map > Administration - Server Configuration > Enterprises.
b) Verify/Change the ff Parameters:

• Data Cleansing Type—G1Cleansing
• DeDuplication Data Type—G1DataMatching

c) Click Component Definitions and select the ff components. For each component, verify
parameters and values.

Table 4: Siebel Business

Value/Value on RestartParameterComponent Definitions

G1CleansingData Cleansing Type*Data Quality Manager *Sales Object
Manager (ENU) *List Import Service
Manager

TrueData Cleansing Enable Flag

G1DataMatchingDeDuplication Data Type

TrueDeDuplication Enable Flag
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Table 5: Siebel Industry

Value/Value on RestartParameterComponent Definitions

G1CleansingData Cleansing Type*Data Quality Manager *eAutomotive
Object Manager (ENU) *List Import
Service Manager

TrueData Cleansing Enable Flag

G1DataMatchingDeDuplication Data Type

TrueDeDuplication Enable Flag

d) Select Site Map > Server Configuration > Servers. Repeat steps b through c for server
configuration parameters.

e) Select Site Map > User Profile Preferences > Data Quality. Change the following settings:

ValueParameter

YesEnable DeDuplication

YesEnable Data Cleansing

f) Browse to <Siebel Installation>\bin\ENU and open the appropriate file:

• Siebel Business: siebel.cfg and uagent.cfg
• Siebel Industry: auto.cfg

g) Under the area [DataCleansing] change the ff Parameters:

Enable = TRUE
Type = G1Cleansing

h) Under the area [DeDuplication] change the ff Parameters:

Enable = TRUE
Type = G1DataMatching

i) Select Site Map > Administration - Server Configuration. Click the Synchronize link and
select Synchronize after being redirected.

17. Configure data cleansing configuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the

Vendor Applet, include the ff value
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DLL NameName

Group1ConnectorG1Cleansing

b) Add the ff BC Vendor Field Mapping:

Table 6: Siebel Business

OperationBusiness Component

Data CleansingAccount

Data CleansingBusiness Address

Data CleansingContact

Data CleansingList Mgmt Prospective Contact

Data CleansingPersonal Address

Table 7: Siebel Industry

OperationBusiness Component

Data CleansingAccount

Data CleansingCUT Address

Data CleansingContact

Data CleansingList Mgmt Prospective Contact

Data CleansingPersonal Address

c) Under each BC operation, add the ff field mappings:
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Table 8: Siebel Business

Mapped FieldBusiness Component Field

Account

FirmNameName

Business Address

CityCity

CountryNameCountry

USCountyNameCounty

DisableDataCleansingDisable DataCleansing

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

RDIG1 Residential Delivery Indicator

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name
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Mapped FieldBusiness Component Field

LastNameLast Name

TitleOfRespectM/M

MiddleNameMiddle Name

List Management Prospective Contact

CityCity

CountryNameCountry

USCountyNameCounty

DisableDataCleansingDisable DataCleansing

FirstNameFirst Name

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

RDIG1 Residential Delivery Indicator

LastNameLast Name

MiddleNameMiddle Name

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address
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Mapped FieldBusiness Component Field

AddressLine2Street Address 2

Personal Address

CityCity

CountryNameCountry

USCountyNameCounty

DisableDataCleansingDisable DataCleansing

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LongitudeG1 Longitude

RDIG1 Residential Delivery Indicator

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Table 9: Siebel Industry

Mapped FieldBusiness Component Field

Account

FirmNameName

CUT Address

CityCity
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Mapped FieldBusiness Component Field

CountryNameCountry

USCountyNameCounty

DisableDataCleansingDisable Data Cleansing

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

RDIG1 Residential Delivery Indicator

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name

LastNameLast Name

MiddleNameMiddle Name

TitleOfRespectM/M

List Management Prospective Contact

CityCity
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Mapped FieldBusiness Component Field

CountryNameCountry

USCountyNameCounty

DisableDataCleansingDisable DataCleansing

FirstNameFirst Name

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

RDIG1 Residential Delivery Indicator

LastNameLast Name

MiddleNameMiddle Name

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Personal Address

CityCity

CountryNameCountry

USCountyNameCounty
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Mapped FieldBusiness Component Field

DisableDataCleansingDisable DataCleansing

DPVG1 Delivery Point Validation Indicator

LatitudeG1 Latitude

LongitudeG1 Longitude

RDIG1 Residential Delivery Indicator

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

d) Add the ff Vendor Parameters.

Table 10: Siebel Business

ValueName

AccountAccount DataCleanse Record Type

Business AddressBusiness Address DataCleanse Record Type

ContactContact DataCleanse Record Type

List Mgmt Prospective ContactList Mgmt Prospective Contact DataCleanse Record
Type

Personal AddressPersonal Address DataCleanse Record Type
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Table 11: Siebel Industry:

ValueName

AccountAccount DataCleanse Record Type

CUT AddressCUT Address DataCleanse Record Type

ContactContact DataCleanse Record Type

List Mgmt Prospective ContactList Mgmt Prospective Contact DataCleanse Record
Type

Personal AddressPersonal Address DataCleanse Record Type

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data
Quality Settings. Add the ff data for Data Quality Settings. These settings enable data
cleansing for your Siebel Application

ValueName

YesEnable DataCleansing

18. Configure data matching configuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the

Vendor Applet, include the ff value

DLL NameName

Group1ConnectorG1DataMatching

b) Add the ff BC Vendor Field Mapping:

Table 12: Siebel Business Applications

OperationBusiness Component

DeDuplicationAccount

DeDuplicationBusiness Address
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OperationBusiness Component

DeDuplicationContact

DeDuplicationList Mgmt Prospective Contact

Table 13: Siebel Industry Applications

OperationBusiness Component

DeDuplicationAccount

DeDuplicationCUT Address

DeDuplicationContact

DeDuplicationList Mgmt Prospective Contact

c) Under each BC Operation, add the ff Field Mappings.

Table 14: Siebel Business Applications

Mapped FieldBusiness Component Field

Account

DedupTokenDedup Token

IdId

LocationLocation

NameName

CityPrimary Account City

CountryNamePrimary Account Country

PostalCodePrimary Account Postal Code
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Mapped FieldBusiness Component Field

StateProvincePrimary Account State

AddressLine1Primary Account Street Address

Business Address

CityCity

CountryNameCountry

IdId

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

AccountNamePrimary Account Name

CityPrimary City

CountryNamePrimary Country

PostalCodePrimary Postal Code

StateProvincePrimary State
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Mapped FieldBusiness Component Field

List Management Prospective Contact

AccountAccount

CityCity

CountryNameCountry

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Table 15: Siebel Industry Applications

Mapped FieldBusiness Component Field

Account

DedupTokenDedup Token

IdId

LocationLocation

NameName

CityPrimary Account City
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Mapped FieldBusiness Component Field

CountryPrimary Account Country

PostalCodePrimary Account Postal Code

StatePrimary Account State

AddressLine1Primary Account Street Address

CUT Address

CityCity

CountryCountry

IdId

PostalCodePostal Code

StateState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

NamePrimary Account Name

CityPrimary City

CountryPrimary Country
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Mapped FieldBusiness Component Field

CodePrimary Postal Code

StatePrimary State

List Management Prospective Contact

AccountAccount

CityCity

CountryNameCountry

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

d) Add the ff Vendor Parameters:

Token Expression and Query Expression are custom fields in their respective Business
Components.

Note:

Table 16: Vendor Parameters

ValueName

AccountAccount DeDup Record Type
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ValueName

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

Account Query Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

Account Token Expression

200Batch Max Num of Records

Business Address(Siebel Business Only)

Business Address DeDup Record Type

CUT Address(Siebel Industry Only)

CUT Address DeDup Record Type

ContactContact DeDup Record Type

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

Contact Query Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

Contact Token Expression

List Mgmt Prospective ContactList Mgmt Prospective Contact DeDup Record Type

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

List Mgmt Prospective Contact Query Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

List Mgmt Prospective Contact Token Expression

200Realtime Max Num of Records

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data
Quality Settings. Add the ff data for Data Quality Settings. These settings enable datamatching
for your Siebel Application.

ValueName

YesEnable DeDuplication
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ValueName

YesForce User DeDupe - Account

YesForce User DeDupe - Contact

YesForce User DeDupe - List Mgmt

19. (Open UI Only) Grant the EAI File Transport business service access to the file system by following
these steps.
a) Click Navigate > Site map.
b) Click Administration - Server Configuration.
c) In theAdministration - Server Configuration section, under Enterprises, click Parameters.
d) Click Query.
e) In the Name column, enter EAI File Transport Folder List.
f) Click Go.
g) In the Value column, enter the root of the drive where you have Siebel installed. For example,

C:\.
h) Click the Servers link:

i) Click the Parameters tab:
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j) Click Query.
k) In the Name column, enter EAI File Transport Folder List.
l) Click Go.
m) In the Value column, enter the root of the drive where you have Siebel installed. For example,

C:\.
n) Add the following values to the the .cfg file appropriate for your system (for example, auto.cfg,

tools.cfg, and so on).

[EAIFileTransportConfigSubsys]
EAIFileTransportFolders=C:\

o) Restart the Siebel server and gateway.

20. Set the EditProfileAttr parameter:
a) Click Navigate > Site Map
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Servers, click Components.
d) On the Components tab, click Query.
e) In the Component column, enter the name of the Object Manager component. For example,

"eAutomotive Object Manager".
f) Click Go.
g) Click the Parameters tab at the bottom of the window.
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h) Scroll to the parameter EditProfileAttr.
i) Enter True in the Value, Value on Restart, and Default Value columns.

You have now configured Siebel SDQ to use Spectrum™ Technology Platform for data quality
processing.
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Integrating with Siebel Non-SDQ

To integrate Spectrum™ Technology Platform with Siebel Non-SDQ, you need to install supporting
databases and dataflows on the Spectrum™ Technology Platform server, and then configure your
Siebel system to communicate with Spectrum™ Technology Platform. Once you do this, users of
Siebel Non-SDQ will have access to address validation and geocoding functionality from within
Siebel Non-SDQ.

1. On the Spectrum™ Technology Platform server, install the databases required to perform address
validation, geocoding, and tax jurisdiction assignment and define database resources for each
database.

You must give the database resources the following names.

Required Name for Database ResourceDatabase

IGEO_CANEnterprise Geocoding Module - Canada Database

EGM_USEnterprise Geocoding Module - U.S. Database

ETMEnterprise Tax Module Database

CanadaUniversal Addressing Module - Canada Database

LoqateUniversal Addressing Module - Loqate Database

UAM_USUniversal Addressing Module - U.S. Database

2. When you install the Siebel module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into the Spectrum™ Technology Platform server.
a) Browse to one of the following folders on your Spectrum™ Technology Platform server:

• For Siebel Business Applications, go to:
<SpectrumPlatformLocation>\server\modules\dataflows\siebel\sea

• For Siebel Industry Applications, go to:
<SpectrumPlatformLocation>\server\modules\dataflows\siebel\sia

b) Review the following table then copy the applicable dataflow files to:

SpectrumLocation\server\app\import
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Table 17: Dataflow Files To Import

Copy these dataflow files to the import folderIf you are installing this set of
modules

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.ADN.df

Address Now Module only

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_ADN.df

Address Now Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.EGM_ADN.df

Address Now Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_EGM_ADN.df

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates.UAM.df

Universal Addressing Module only

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates.UAM_EGM.df

Universal Addressing Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_UAM_ETM.df

Universal Addressing Module
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate.dfUniversal Address Module with Loqate

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module
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Copy these dataflow files to the import folderIf you are installing this set of
modules

ValidateAddressWithCandidates_Loqate_EGM.dfUniversal Addressing Module, Loqate
only
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.dfUniversal Addressing Module with
Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_Loqate.dfUniversal Addressing Module, Loqate
only

ValidateAddressWithCandidates.EGM.df
Enterprise Geocoding Module

ValidateAssignGeoTAXInfo.df
Enterprise Tax Module

If errors occur in Management Console or Enterprise Designer, delete the client cache.
To delete the client cache, go to Tools >Options in Management Console or Enterprise

Note:

Designer, click the Advanced tab, then click Clear Cache. After you clear the cache,
restart Management Console or Enterprise Designer.

3. Optional: If you are using the Enterprise Geocoding Module, configure the geocoding dataflow
to use the geocoding database resource name you have configured on your system:
a) In Enterprise Designer, open the dataflow GeocodeUSAddressWithCandidates.
b) In each dataflow, open the Geocode US Address stage.
c) In the Database field, select the name of the geocoding database as defined in the

Management Console. The default name is KGDDatasource but if the geocoding database
has a different name on your system, select the appropriate name.

For more information about database resources, see the Spectrum™ Technology
Platform Administration Guide.

Note:
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d) Save and close each dataflow.

4. Copy Siebel objects to your system:
a) Browse to the location where you downloaded the Spectrum™ Technology Platform installer.
b) Browse to the appropriate folder for your version of Siebel as shown in the following table.

FolderSiebel Version

Siebel Objects\8.0\Business\non
SDQ

Siebel Business Applications 8.0 Non-SDQ

Siebel Objects\8.1.1\Business\non
SDQ

Siebel Business Applications 8.1.1 Non-SDQ

Siebel Objects\8.0\Industry\non
SDQ

Siebel Industry Applications 8.0 Non-SDQ

Siebel Objects\8.1.1\Industry\non
SDQ

Siebel Industry Applications 8.1.1 Non-SDQ

c) Copy the contents of the folder to a temporary directory.

This temporary folder will be the referred to as <Spectrum Package> in the following
steps.

Note:

5. Create objects and allow object locking:
a) Log in to Siebel Tools as the user SADMIN, with the connection pointing to the server data

source.
b) Go to Object Explorer, drill down to the Project object. From the Project area, right-click and

select New Record. Create the following projects:

• Group 1 Data Quality
• Group 1 EAI Testing
• Group 1 Workflow

c) Open the file <Spectrum Package>\tools\CDQP_Queries.txt.
d) Copy and paste the query contents to the Project list of your Object Manager. Cross-check

the query result with the table below and perform the action suggested. To toggle object
locking, go to Object Explorer and browse to the Project object. From the Project area, right-click
and select the project, and select Toggle Object Locking.
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Table 18: Queries for Siebel non-SDQ

ActionProjectOpen UISiebel Industry
Applications

Siebel Business
Applications

Toggle Object
Locking

AccountXXX

Toggle Object
Locking

Account (SCW)XXX

Toggle Object
Locking

Account (SSE)XXX

Toggle Object
Locking

ContactXXX

Toggle Object
Locking

Contact (SSE)XXX

Toggle Object
Locking

CUT AccountXX

Toggle Object
Locking

CUT Siebel
Communications

XX

Toggle Object
Locking

CUT UsageXX

Toggle Object
Locking

DNB DataXXX

Toggle Object
Locking

DeDuplicationXXX

Toggle Object
Locking

eAutomotiveXX

Toggle Object
Locking

EmployeeXXX

Toggle Object
Locking

FINS ContractXX
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ActionProjectOpen UISiebel Industry
Applications

Siebel Business
Applications

Toggle Object
Locking

FINS Contract InfoXX

Toggle Object
Locking

FINS Deal
Commercial

XX

Toggle Object
Locking

FINS Financial
Services

XX

Toggle Object
Locking

FINS OpportunityXX

Create and Toggle
Object Locking

Group 1 Data QualityXXX

Create and Toggle
Object Locking

Group 1 EAI TestingXXX

Create and Toggle
Object Locking

Group 1 WorkflowXX

Toggle Object
Locking

List Mgmt (Import)X

Toggle Object
Locking

List Mgmt (UI)XXX

Toggle Object
Locking

MvgX

Toggle Object
Locking

OpptyXXX

Toggle Object
Locking

Oppty (SSE)XXX

Toggle Object
Locking

Personal ContactXXX

Toggle Object
Locking

PicklistXXX
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ActionProjectOpen UISiebel Industry
Applications

Siebel Business
Applications

Toggle Object
Locking

Server Component
Requests

XXX

Toggle Object
Locking

Siebel Sales
Enterprise

XX

Toggle Object
Locking

Siebel Universal
Agent

X

Toggle Object
Locking

VERT CUT AddressXX

Toggle Object
Locking

VERT Cut CommonXX

6. Check out the Siebel Projects:
a) Log in to Siebel Tools on Local Datasource.
b) Select Tools > Checkout.
c) Select the projects indicated in the following table and click Checkout.

Table 19: Siebel Projects for non-SDQ

ProjectSiebel Industry ApplicationsSiebel Business Applications

AccountXX

Account (SCW)XX

Account (SSE)XX

ContactXX

Contact (SSE)XX

CUT AccountX

CUT Siebel CommunicationsX

CUT UsageX
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ProjectSiebel Industry ApplicationsSiebel Business Applications

DNB DataXX

DeDuplicationXX

eAutomotiveX

EmployeeXX

FINS ContractX

FINS Contract InfoX

FINS Deal CommercialX

FINS Financial ServicesX

FINS OpportunityX

Group 1 Data QualityXX

Group 1 EAI TestingXX

Group 1 WorkflowX

List Mgmt (Import)X

List Mgmt (UI)XX

MvgX

OpptyXX

Oppty (SSE)XX

Personal ContactXX

PicklistXX

Server Component RequestsXX
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ProjectSiebel Industry ApplicationsSiebel Business Applications

Siebel Sales EnterpriseX

Siebel Universal AgentX

VERT CUT AddressX

VERT Cut CommonX

7. Import the Spectrum™ Technology Platform Siebel objects:
a) Select Tools > Import from Archive.
b) Import the Siebel SIF files located in <Spectrum Package>\sif. Select Overwrite the

object definition in the repository and click Next to proceed until the import process has
been completed.

• G1_NEW.sif
• G1_APPLET.sif
• G1_BO.sif
• G1_LINK.sif
• G1_BC.sif
• G1_BC_SCRIPTS.sif
• G1_EAI_TESTING.sif
• G1_APPLICATION.sif
• G1_PICKLIST.sif
• G1_VIEW.sif
• G1_WORKFLOW.sif
• (8.1.1 only) Rebranding.sif

c) (Open UI Only) Import the Siebel SIF files located in <Spectrum Package>\OPEN_UI.
Select Overwrite the object definition in the repository and click Next to proceed until the
import process has been completed.

• FINS Personal Address List Applet.sif
• G1 Common Browser Scripts Service.sif
• Siebel Sales Enterprise.sif

8. Check in all locked projects:
a) Select Tools > Check In.
b) Select all the Projects to check in and click Check in.

9. Compile all Projects:
a) Select Tools > Compile Projects.
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b) Click All Projects.
c) In the Siebel Repository File field, enter the path of your Siebel Web Client SRF file.
d) Click Compile.

10. Update the application .CFG flie:
a) Open the appropriate .cfg file in an editor:

For example, for Siebel Business:

• Siebel Call Center—uagent.cfg

• Siebel Sales—siebel.cfg

For example, for Siebel Industry:

• eAutomotive—auto.cfg

• Financial—fins.cfg

• eCommunication—ecomm.cfg

Siebel .cfg files are usually found in the following locations:

• Siebel thick client—Siebel\<version>\web client\bin\enu

• Siebel thin client—<Siebel Server>\bin\enu

b) Add the following lines under the [SWE] section:

ClientBusinessService0 = G1 Async Service
ClientBusinessService1 = G1 Business Name Standardization Service
ClientBusinessService2 = G1 Common Browser Scripts Service
ClientBusinessService3 = G1 Common Server Scripts Service
ClientBusinessService4 = G1 DNB VBC Service
ClientBusinessService5 = G1 Data Cleansing Service
ClientBusinessService6 = G1 DeDuplication Service
ClientBusinessService7 = G1 Generate HashKey Service
ClientBusinessService8 = G1 GeoCoding Service
ClientBusinessService9 = G1 Interactive Service
ClientBusinessService10 = G1 Merge Records Service
ClientBusinessService11 = G1 Name Casing Service
ClientBusinessService12 = G1WebService

11. Deploy the Siebel objects in the client:

Keep a backup of the old SRF in case old binaries need to be re-implemented.Note:

a) Copy the generated SRF to your web client objects folder.

For example, on Windows this folder may be C:\Program Files\Siebel\8.0\web
client\OBJECTS\ENU. On Unix or Linux this folder may be
/disk2/sia78/webclient/OBJECTS/enu/.

b) Open a command prompt and go to the BIN folder of the web client.
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For example, on Windows this folder may be C:\Program Files\Siebel\8.0\web
client\BIN. On Unix or Linux, this folder may be /disk2/sia80/webclient/BIN.

c) Generate browser scripts by issuing the command:

On Windows:

genbscript "ENU\siebel.cfg" "[public\enu folder]"

On Unix or Linux:

genbscript [location of .cfg] [public/enu folder]

For example, on Windows:

C:\Program Files\Siebel\8.0\web client\BIN>genbscript "enu\siebel.cfg"
"C:\Program Files\Siebel\8.0\web client\PUBLIC\enu"

On Unix or Linux:

genbscript /disk2/sia80/webclient/BIN/enu/siebel.cfg
sia80/webclient/PUBLIC/enu

d) Copy g1_check.gif and g1_x.gif from the temporary folder to public\enu\images in
the Siebel web client.

e) Copy the contents of <Spectrum Package>\dll to your BIN folder.
f) Copy the contents of <Spectrum Package>\cfg to your BIN/ENU folder.

12. Deploy the Siebel objects to the server:
a) Stop the Siebel server.
b) Copy the generated SRF file to your web client objects folder.

For example, for Siebel Business on Windows the folder may be
C:\sea80\siebsrvr\OBJECTS\ENU. On Unix or Linux the folder may be
/disk2/sea80/siebsrvr/OBJECTS/enu/.

c) Open a command prompt and go to the BIN drive of the web client.

For example, on Windows this folder may be C:\sia80\siebsrvr\BIN. On Unix or Linux
this folder may be /disk2/sea80/siebsrvr/BIN.

d) Generate browser scripts by issuing this command:

On Windows:

genbscript "ENU\siebel.cfg" "[webmaster folder]"

On Unix or Linux:

genbscript [location of Siebel.cfg] [webmaster folder]

For example, on Windows:

C:\sia80\siebsrvr\BIN>genbscript "enu\siebel.cfg"
"C:\sia80\siebsrvr\WEBMASTER"
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For example, on Unix or Linux:

genbscript /disk2/sea80/siebsrvr/BIN/enu/siebel.cfg
/disk2/sea80/siebsrvr/WEBMASTER/

e) Copy g1_check.gif and g1_x.gif from the temporary folder to the following folder on the
Siebel sever.

On Windows:

public\enu\images

On Unix or Linux:

WEBMASTER/images/enu

For Siebel Thin Client, copy g1_check.gif and g1_x.gif from the temporary
directory to SWEApp/PUBLIC/enu/images.

Note:

f) Copy the generated browser scripts from /WEBMASTER to <SWEApp
Location>/public/ENU.

g) Start the Siebel server.

13. Activate the Spectrum™ Technology Platform workflows in the Siebel web client:
a) Log in to the Siebel Application, connecting to the server data source.
b) Select Site Map > Administration - Business Process >Workflow Deployment.
c) Query for all the GROUP 1* workflows.
d) Click Activate for each workflow.
e) Query for all the Promote* workflows.
f) ClickActivate for the ff workflowsPromote Prospect (Single) andPromote Prospect (Many).

14. Load the Group 1 configuration.
a) Log in to the Siebel application connecting to the server data source.
b) Go to Site Map > Administration - Business Service > Simulator.
c) In the top applet, create a new record and set the following fields:

Workflow Process ManagerService Name

Run ProcessMethod Name

1Iterations

d) In the Input Arguments applet, load:

<Spectrum Package>\tools\OptionsManagerLoadData.xml

Delete the entry if previous GROUP 1 options already exist in the database. Run the
following SQL Script: DELETE SIEBEL.S_LST_OF_VAL WHERE CODE = 'G1'

Note:
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e) Click Run in the top applet of the Simulator view. Delete the record.
f) Repeat steps c. and d. for the ff files:

• ViewAccessLoadData.xml
• AdminAccessLoadData.xml

g) Go to Site Map > Administration - Application > Responsibilities:
h) Query for the responsibility Group 1 Responsibility.
i) In the Users tab, add SADMIN or any Siebel administrator. This associates the Group 1

Administration Screen to the user.

In order to see the changes you must log-in again.Note:

j) Go to Site Map > Administration - Group 1 Data Quality > Options Manager > General
Behavior.

k) Change the server and port number where the Spectrum™ Technology Platform server is
located.

15. Verify the installation:
a) Log in to Siebel Application.
b) All applets should load properly without error.

16. Modify and apply web services.
a) Go to Site Map > Administration - Web Services > Outbound Web Services.
b) Click Import on the Outbound Web Services area and then specify the file <Spectrum

Package>\tools\G1WebService.xml.
c) Query on the Name field ValidateAddress, and modify its settings as follows:

On the Service Port applet, change the following fields:

• Transport: Local Business Service
• Address: G1 WebService Filter Service

On the Operations applet, change the following fields:

• Response Filter Service Display: G1 WebService Filter Service
• Response Filter Method Display: filter Response

17. Encrypt and apply Spectrum™ Technology Platform user name and password.
a) Run the following command on the command prompt:

java -version

Java Runtime Environment (JRE) 1.4.x is required. If none is installed, you can download
from java.sun.com/j2se/1.4.2/download.html. Download the JRE of your target platform.

b) Acquire the file <Spectrum Package>\tools\Base64.class.
c) On the command prompt, type the following command:

java Base64 -encode -s "<username>:<password>"
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where <username> and <password> is to the login information of Spectrum™ Technology
Platform server. Copy the generated value.

The default Spectrum™ Technology Platform password can be found in <Spectrum
Package>\tools\Default Password.txt.

Note:

d) Go to Site Map > Administration - Group 1 Data Quality > Password Manager. Paste the
value generated in step c. and click Save Changes.

18. Configure Siebel server configuration events.

The Siebel server must be configured so that the records created in the local database can be
synchronized to the server.

a) Navigate to View > Administration - Server Configuration > Servers > Components >
Event.

b) Locate the Workflow Process Manager Server components.
c) Set the following Component Event Configuration for Workflow Process Manager:

4Task Configuration

3Component Tracing

4SQL Parse and Execute

4Workflow Definition Loading

4Workflow Engine Invoked

4Workflow Step Execution

4Workflow Process Execution

4Object Manager Business Service Operation and
SetErrorMsg Log

4Object Manager Business Component Operation and
SetErrorMsg Log

4Object Manager SQL Log

d) Locate the Transaction Merger server components.
e) Set the following Component Event Configuration for Transaction Merger:
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4General Events

3Components Tracing

4SQL Parse and Execute

19. Enable marketing server components.

The Marketing Server Components must be enabled to import a list from the List Management
business object.

a) Navigate to Administration - Server Configuration > Enterprises > Component Groups.
b) In the Spectrum™ Technology Platform Server list, select the appropriate server.
c) In the Enterprise Component Groups list, locate each of the required component groups using

the following table. If the Enable State field does not contain the value Enabled, select the
component groups, click the menu button, and choose Enable Component Group.

DescriptionComponentsGroup Name

Marketing Object Manager. Supports
the user interface and business
objects for the Marketing application.

MktgOM
• Marketing Obj Mgr
• eMarketing Obj Mgr
• eEvents Obj Mjr

Marketing Server. Used for list
management list import.

List Import Service ManagerMktg Srv

d) Click the Synchronize view tab and click Synchronize.
e) Restart the Siebel server. The Siebel server must be restarted each time synchronization

occurs.

20. (Open UI Only) Grant the EAI File Transport business service access to the file system by following
these steps.
a) Click Navigate > Site map.
b) Click Administration - Server Configuration.
c) In theAdministration - Server Configuration section, under Enterprises, click Parameters.
d) Click Query.
e) In the Name column, enter EAI File Transport Folder List.
f) Click Go.
g) In the Value column, enter the root of the drive where you have Siebel installed. For example,

C:\.
h) Click the Servers link:
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i) Click the Parameters tab:

j) Click Query.
k) In the Name column, enter EAI File Transport Folder List.
l) Click Go.
m) In the Value column, enter the root of the drive where you have Siebel installed. For example,

C:\.
n) Add the following values to the the .cfg file appropriate for your system (for example, auto.cfg,

tools.cfg, and so on).

[EAIFileTransportConfigSubsys]
EAIFileTransportFolders=C:\

o) Restart the Siebel server and gateway.

21. Set the EditProfileAttr parameter:
a) Click Navigate > Site Map
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Servers, click Components.
d) On the Components tab, click Query.
e) In the Component column, enter the name of the Object Manager component. For example,

"eAutomotive Object Manager".
f) Click Go.
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g) Click the Parameters tab at the bottom of the window.

h) Scroll to the parameter EditProfileAttr.
i) Enter True in the Value, Value on Restart, and Default Value columns.

You have now configured Siebel non-SDQ to use Spectrum™ Technology Platform for data quality
processing.
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Configuring Microsoft Dynamics CRM

Integrating with Microsoft Dynamics CRM

To integrate Spectrum™ Technology Platform with Microsoft Dynamics CRM, you need to install
supporting databases and dataflows on the Spectrum™ Technology Platform server, and deploy
the Spectrum™ Technology Platform solution on your Microsoft Dynamics CRM server. Once you
do this, users of Microsoft Dynamics CRM will have access to address validation, geocoding, and
duplicate detection functionality from within Microsoft Dynamics CRM.

End users who use Internet Explorer must use Internet Explorer 10 or 11. Older versions of
Internet Explorer are not supported. All versions of Chrome and Firefox are supported.

Note:

1. If you are using Spectrum™ Technology Platform for address validation or geocoding, install the
databases required to perform address validation and geocoding and define database resources
for each database.

If you are using Spectrum™ Technology Platform for duplicate detection only, you can
skip this step.

Note:

You must give the database resources the following names.

Required Name for Database ResourceDatabase

IGEO_CANEnterprise Geocoding Module - Canada Database

EGM_USEnterprise Geocoding Module - U.S. Database

CanadaUniversal Addressing Module - Canada Database

LoqateUniversal Addressing Module - Loqate Database

UAM_USUniversal Addressing Module - U.S. Database

You must install the Delivery Point Validation (DPV) data and the Residential Delivery
Indicator (RDI) data in order to perform DPV and RDI processing on U.S. addresses.

Note:
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2. Import the Microsoft Dynamics CRMModule dataflows into your Spectrum™ Technology Platform
server.
a) On the Spectrum™ Technology Platform server, open this folder:

SpectrumFolder\server\modules\dataflows\mscrm

This folder is only available if you have installed the Microsoft Dynamics CRMModule.Note:

b) Review the following table then copy the applicable dataflow files to:

SpectrumFolder\server\app\import

Copy these dataflow files to the import folderIf you have installed this set of
modules

GenerateMatchKey.df
GenerateMatchScore.df

Advanced Matching Module

GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

ValidateAddresswithCandidates_UAM.df
Universal Addressing Module without
Loqate

ValidateAddressWithCandidates_UAM_EGM.df
Universal Addressing Module without
Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate.df
Universal Addressing Module with
Loqate

BatchAddressValidate.df
ValidateAddressAndGenerateMatchKey.df
ValidateAddressWithCandidates_UAM_Loqate_EGM.df

Universal Addressing Module with
Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate.df
Universal Addressing Module, Loqate
only
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Copy these dataflow files to the import folderIf you have installed this set of
modules

ValidateAddressWithCandidates_Loqate_EGM.df
Universal Addressing Module, Loqate
only
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
Enterprise Geocoding Module

3. Import the Microsoft Dynamics CRM Module into your Microsoft Dynamics CRM system.
a) In the Spectrum™ Technology Platform installation package, browse to this folder:

MS CRM Objects\MS CRM Dynamics 2013\MSCRM Object\

b) Copy the file netProxy.aspx to the following folder on you Microsoft Dynamics CRM server:
MicrosoftDynamicsCRMInstallation\CRMWeb

c) Copy the file netProxy.dll to the following folder on you Microsoft Dynamics CRM server:
MicrosoftDynamicsCRMInstallation\CRMWeb\Bin

d) Log in to Microsoft Dynamics CRM as an administrator.
e) Click Microsoft Dynamics CRM then click Settings.
f) Click Solutions.
g) Click Import.
h) Browse to the the Spectrum™ Technology Platform installation package and select the following

file:
MS CRM Objects\MS CRM Dynamics 2013\MSCRM
Object\mscrm\PBMSDynamicsCRMConnector_1_0_0_managed.zip

i) Click Next then Publish All Customizations.
j) Restart the Microsoft Dynamics CRM server.

4. Define the connection betweenMicrosoft Dynamics CRMand the Spectrum™ Technology Platform
server.
a) Log in to Microsoft Dynamics CRM as an administrator.
b) Click Microsoft Dynamics CRM > Settings.
c) Click Settings > Pitney Bowes. You will have to scroll to the right to find the Pitney Bowes

link.
d) Click Administration.
e) Click New.
f) In the Name field, enter PB.
g) In the Server Name field, enter the server name or IP address of the Spectrum™ Technology

Platform server.
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h) In the Port field, enter the port used by the Spectrum™ Technology Platform server for HTTP
communication. By default the port is 8080.

i) In the Account ID field, enter the Spectrum™ Technology Platform user name.
j) In the Password field, enter the password for the Spectrum™ Technology Platform user.
k) Click Save

The Microsoft Dynamics CRM system now has access to address validation and, optionally,
geocoding services on the Spectrum™ Technology Platform server.
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9 - Support
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Technical Support

If you run into an issue, Pitney Bowes Technical Support can help guide you to a solution. When
you contact Pitney Bowes Technical Support, please provide the following information:

• A description of the task you were performing
• The level or version of your operating system
• The patch level or service pack
• The log file located in your install directory at:
<SpectrumInstallationLocation>\server\app\repository\logs\wrapper.log

Contact information for Technical Support can be found at:

www.g1.com/Support/Contact

If you purchased Spectrum™ Technology Platform through a third-party partner, please
contact the partner for technical support.

Note:

Documentation

Product documentation can be found at:

support.pb.com/spectrum

Digital Insights

Digital Insights is an online resource for Pitney Bowes leadership to share innovations, goals, and
product news, as well as exchange ideas with visitors. You can access Digital Insights at:

blogs.pb.com/digital-insights/
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Notices



© 2015 Pitney Bowes Software Inc. All rights reserved. MapInfo and Group 1 Software are trademarks
of Pitney Bowes Software Inc. All other marks and trademarks are property of their respective
holders.

USPS® Notices

Pitney Bowes Inc. holds a non-exclusive license to publish and sell ZIP + 4® databases on optical
and magnetic media. The following trademarks are owned by the United States Postal Service:
CASS, CASS Certified, DPV, eLOT, FASTforward, First-Class Mail, Intelligent Mail, LACSLink,
NCOALink, PAVE, PLANET Code, Postal Service, POSTNET, Post Office, RDI, SuiteLink , United
States Postal Service, Standard Mail, United States Post Office, USPS, ZIP Code, and ZIP + 4.
This list is not exhaustive of the trademarks belonging to the Postal Service.

Pitney Bowes Inc. is a non-exclusive licensee of USPS® for NCOALink® processing.

Prices for Pitney Bowes Software's products, options, and services are not established, controlled,
or approved by USPS® or United States Government. When utilizing RDI™ data to determine
parcel-shipping costs, the business decision on which parcel delivery company to use is not made
by the USPS® or United States Government.

Data Provider and Related Notices

Data Products contained on this media and used within Pitney Bowes Software applications are
protected by various trademarks and by one or more of the following copyrights:
© Copyright United States Postal Service. All rights reserved.
© 2014 TomTom. All rights reserved. TomTom and the TomTom logo are registered trademarks of
TomTom N.V.
© 1987 - 2014 HERE. All rights reserved.

Fuente: INEGI (Instituto Nacional de Estadística y Geografía)

Based upon electronic data © National Land Survey Sweden.
© Copyright United States Census Bureau
© Copyright Nova Marketing Group, Inc.

Portions of this program are © Copyright 1993-2007 by Nova Marketing Group Inc. All Rights
Reserved
© Copyright Second Decimal, LLC
© Copyright Canada Post Corporation

This CD-ROM contains data from a compilation in which Canada Post Corporation is the copyright
owner.
© 2007 Claritas, Inc.

The Geocode Address World data set contains data licensed from the GeoNames Project
(www.geonames.org) provided under the Creative Commons Attribution License ("Attribution
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License") located at http://creativecommons.org/licenses/by/3.0/legalcode. Your use of the
GeoNames data (described in the Spectrum™ Technology Platform User Manual) is governed by
the terms of the Attribution License, and any conflict between your agreement with Pitney Bowes
Software, Inc. and the Attribution License will be resolved in favor of the Attribution License solely
as it relates to your use of the GeoNames data.

ICU Notices

Copyright © 1995-2011 International Business Machines Corporation and others.

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESSFORAPARTICULARPURPOSEANDNONINFRINGEMENTOFTHIRDPARTYRIGHTS.
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE
BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising
or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.
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